Installation Guide

Installation Guide – SAP NetWeaver Composition Environment 7.1 SP3 on Windows: MS SQL Server

Productive Edition

Target Audience

- System Administrators
- Technical Consultants

Document version: 1.0 – 11/05/2007
Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at the following location: http://www.sdn.sap.com > SAP NetWeaver > Composition Environment.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>11/5/2007</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
# Table of Contents

## Chapter 1
- **Introduction** .................................................. 7
- 1.1 New Features .................................................. 7
- 1.2 SAP Notes for the Installation ................................. 8
- 1.3 Information Available on SAP Service Marketplace ............ 10
- 1.4 Naming Conventions ............................................ 11

## Chapter 2
- **Planning** ..................................................... 13
- 2.1 Installation Options Covered by this Guide .................... 13
- 2.1.1 Standard System ........................................... 14
- 2.1.2 Distributed System ......................................... 15
- 2.1.3 High Availability System ................................... 15
- 2.1.4 Additional Application Server Instance ..................... 16
- 2.1.5 Standalone Host Agent ..................................... 17
- 2.2 Distribution of SAP System Components to Disks ............... 18
- 2.3 SAP System Transport Host .................................... 21
- 2.4 Running Adobe Document Services on Non-Supported Platforms 22
- 2.5 Database Installation for Multiple Components with MS SQL Server 22
- 2.5.1 Default or Named MS SQL Server Instances ............... 23
- 2.6 Installation of Multiple Components in One Database .......... 24

## Chapter 3
- **Preparation** .................................................. 27
- 3.1 Basic SAP System Parameters ................................... 28
- 3.2 Hardware and Software Requirements ........................ 34
- 3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional) 36
- 3.2.2 Requirements for a Standard System ........................ 36
- 3.2.3 Requirements for a Distributed System ...................... 38
- 3.2.4 Requirements for a High-Availability System ............... 40
- 3.2.5 Requirements for the Host Agent as a Separate Installation 44
- 3.3 Preparing User Management for an External ABAP System .... 45
- 3.4 Checking the Windows File System ............................. 48
- 3.5 Checking the Windows Domain Structure ........................ 48
- 3.6 Reducing the Size of the File Cache ............................ 49
- 3.7 Required User Authorization for the Installation ............... 49
- 3.8 Performing a Domain Installation Without Being a Domain Administrator 51
- 3.9 Preparing the SAP System Transport Host ........................ 53
<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Installing the SQL Server Database Software</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Installing the SQL Server Database Software with SQL4SAP</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Installing the SQL Server 2005 Database Server Software Manually</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Installing the SQL Server 2005 Native Client Software Manually</td>
</tr>
<tr>
<td>4.2</td>
<td>Running SAPinst</td>
</tr>
<tr>
<td>4.3</td>
<td>SAPinst Installation Options</td>
</tr>
<tr>
<td>4.4</td>
<td>Installing Additional Components (Optional)</td>
</tr>
<tr>
<td>4.5</td>
<td>Installing SAP Memory Analyzer (Optional)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Post-Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Logging On to the Application Server</td>
</tr>
<tr>
<td>5.2</td>
<td>Installing the SAP License</td>
</tr>
<tr>
<td>5.3</td>
<td>Configuring the Transport Management System</td>
</tr>
<tr>
<td>5.4</td>
<td>Configuring the Remote Connection to SAP Support</td>
</tr>
<tr>
<td>5.5</td>
<td>Applying the Latest Kernel and Support Packages</td>
</tr>
<tr>
<td>5.6</td>
<td>Ensuring User Security</td>
</tr>
<tr>
<td>5.7</td>
<td>Post-Installation Steps for the Host Agent</td>
</tr>
<tr>
<td>5.8</td>
<td>Checking the SAP Java Documentation</td>
</tr>
<tr>
<td>5.9</td>
<td>CE-Specific Post-Installation Activities</td>
</tr>
<tr>
<td>5.10</td>
<td>Performing a Full System Backup</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Updating SAP NetWeaver Composition Environment</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Transporting Self-Developed Software Component Archives (SCA) into the System</td>
</tr>
<tr>
<td>7.2</td>
<td>Troubleshooting — Repairing an Inconsistent MaxDB Installation</td>
</tr>
<tr>
<td>7.3</td>
<td>Restarting the MaxDB Server Manually</td>
</tr>
<tr>
<td>7.4</td>
<td>Restarting the MS SQL Server Manually</td>
</tr>
<tr>
<td>7.5</td>
<td>Configuration Templates</td>
</tr>
<tr>
<td>7.6</td>
<td>SAP Directories</td>
</tr>
<tr>
<td>7.7</td>
<td>Additional Information About SAPinst</td>
</tr>
<tr>
<td>7.7.1</td>
<td>Interrupted Installation with SAPinst</td>
</tr>
<tr>
<td>7.7.2</td>
<td>Performing a Remote Installation with SAPinst (Optional)</td>
</tr>
<tr>
<td>7.7.3</td>
<td>Starting SAPinst GUI Separately (Optional)</td>
</tr>
<tr>
<td>7.7.4</td>
<td>Entries in the Services File Created by SAPinst</td>
</tr>
<tr>
<td>7.7.5</td>
<td>How to Avoid Automatic Logoff by SAPinst</td>
</tr>
<tr>
<td>7.7.6</td>
<td>Troubleshooting with SAPinst</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>7.8</td>
<td>Starting and Stopping the SAP System</td>
</tr>
<tr>
<td>7.9</td>
<td>SAP System Security on Windows</td>
</tr>
<tr>
<td>7.10</td>
<td>Automatic Creation of Accounts and Groups</td>
</tr>
<tr>
<td>7.11</td>
<td>Uninstalling SAP NetWeaver Composition Environment</td>
</tr>
<tr>
<td>7.12</td>
<td>Deleting an SAP System</td>
</tr>
<tr>
<td>8.1</td>
<td>Planning</td>
</tr>
<tr>
<td>8.1.1</td>
<td>System Configuration in MSCS</td>
</tr>
<tr>
<td>8.1.1.1</td>
<td>SAP System Components in an MSCS Configuration</td>
</tr>
<tr>
<td>8.1.1.2</td>
<td>Multiple SAP Systems In One MSCS Cluster</td>
</tr>
<tr>
<td>8.1.1.3</td>
<td>Multiple SAP Systems In Multiple MSCS Clusters</td>
</tr>
<tr>
<td>8.1.1.4</td>
<td>Enqueue Replication Server in an MSCS Configuration</td>
</tr>
<tr>
<td>8.1.2</td>
<td>Distribution of SAP System Components to Disks for MSCS</td>
</tr>
<tr>
<td>8.1.3</td>
<td>Directories in an MSCS Configuration</td>
</tr>
<tr>
<td>8.1.4</td>
<td>IP Addresses in an MSCS Configuration</td>
</tr>
<tr>
<td>8.1.5</td>
<td>Obtaining IP Addresses for MSCS</td>
</tr>
<tr>
<td>8.2</td>
<td>Preparation</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Assigning Drive Letters for MSCS</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Mapping Host Names to IP Addresses for MSCS</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Checking the Mapping of Host Names for MSCS</td>
</tr>
<tr>
<td>8.2.4</td>
<td>Preparing an Existing SAP System to Support Multiple Systems in one MS Cluster</td>
</tr>
<tr>
<td>8.2.5</td>
<td>Preparing the Installation of Multiple SAP Systems in MSCS</td>
</tr>
<tr>
<td>8.3</td>
<td>Installation</td>
</tr>
<tr>
<td>8.3.1</td>
<td>Clustering the SQL Server 2005 Database Server Software</td>
</tr>
<tr>
<td>8.3.2</td>
<td>Moving MSCS Groups</td>
</tr>
<tr>
<td>8.3.3</td>
<td>Rebooting During the Installation or Conversion for MSCS</td>
</tr>
<tr>
<td>8.3.4</td>
<td>Installing the Central Services Instance (SCS)</td>
</tr>
<tr>
<td>8.3.5</td>
<td>Configuring the First MSCS Node</td>
</tr>
<tr>
<td>8.3.6</td>
<td>Installing the Database Instance</td>
</tr>
<tr>
<td>8.3.7</td>
<td>Installing the Host Agent on the Additional MSCS Node</td>
</tr>
<tr>
<td>8.3.8</td>
<td>Configuring the Additional MSCS Node</td>
</tr>
<tr>
<td>8.3.9</td>
<td>Installing an Enqueue Replication Server</td>
</tr>
<tr>
<td>8.3.10</td>
<td>Installing the Primary Application Server Instance</td>
</tr>
<tr>
<td>8.3.11</td>
<td>Installing the Additional Application Server Instance</td>
</tr>
<tr>
<td>8.4</td>
<td>Post-Installation</td>
</tr>
<tr>
<td>8.4.1</td>
<td>Post-Installation Checks for Enqueue Replication Server</td>
</tr>
<tr>
<td>8.4.1.1</td>
<td>Checking the Status of the Enqueue Replication Server with ENSMON</td>
</tr>
<tr>
<td>8.4.1.2</td>
<td>Monitoring the Lock Table During Failover with ENQT</td>
</tr>
<tr>
<td>8.4.2</td>
<td>Starting and Stopping the SAP System in an MSCS Configuration</td>
</tr>
</tbody>
</table>
1 Introduction

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.  
For more information about SAP NetWeaver Composition Environment, see SAP Community Network at [http://sdn.sap.com] SAP NetWeaver > Composition Environment.

1.1 New Features

Here you can find the new features in this release.

Caution
Make sure that you read the release notes for your SAP system. You can find these on SAP Service Marketplace at [http://service.sap.com/releasenotes].

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPinst</td>
<td>SAPinst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
<tr>
<td></td>
<td>- “Central instance” (CI) is now called “primary application server instance”.</td>
</tr>
<tr>
<td></td>
<td>- “Dialog instance” (DI) is now called “additional application server instance”.</td>
</tr>
</tbody>
</table>

Note
The technical terms “Database instance”, “Java central services instance” (SCS), and “ABAP central services instance” (ASCS) remain unchanged.

- “Central system” – meaning an SAP system running on one single host – is now called “standard system”.
- You can now install the host agent separately with SAPinst. There is a new installation option Host Agent available under Software Life-Cycle Options. Additional Preparations.

The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX.

You only need to install the host agent separately in the following cases:
- You want to centrally monitor a host that does not have an SAP component.
- You want to perform an upgrade to SAP NetWeaver.
### 1 Introduction

#### 1.1 New Features

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Deployment Manager (SDM) no longer available in the Application Server Java</td>
<td>The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J&lt;instance_number&gt;. JC&lt;instance_number&gt; no longer exists.</td>
</tr>
</tbody>
</table>
| Usage type EP Core (EPC)                      | The usage type Enterprise Portal (EP) is divided into the usage types EP Core (EPC) and Enterprise Portal (EP):  
  - **EP Core (EPC)**: This usage type contains the core portal capabilities that were available in the former usage type EP. This new usage type provides more flexibility when implementing a portal where the full enterprise portal capabilities, such as knowledge management and collaboration, are not required. It contains the portal, GP, and UWL.  
  - **Enterprise Portal (EP)**: This usage type includes Knowledge management, Collaboration, CAF-Core, Visual Composer, Web Dynpro extension, and .NET PDK. Usage type EPC is a prerequisite for usage type EP. If you want to obtain the full capabilities of the former usage type EP, you need both EP Core and EP. The configuration of EPC comprises only portal configuration steps.                                                                                                                                                                                                                                                                                                                                                           |
| Installation DVDs                             | You start the installation from the Installation Master DVD for your database.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       |
| SAP JVM                                        | You no longer have to download and install a Java Development Kit (JDK) or Java Runtime Environment (JRE) from another software vendor. SAP delivers its own Java Virtual Machine (JVM) called SAP JVM. This virtual machine is certified and fully compliant with the J2SE 5.0 standard, offering a strong and reliable foundation for the whole SAP Java stack. SAP JVM is available on the Installation Master DVD. SAPinst extracts and installs it automatically when you start the installation.                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
| Visual Administrator tool integrated in SAP NetWeaver Administrator | SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator. SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator. For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and SAP Service Marketplace at [http://service.sap.com/nwa](http://service.sap.com/nwa). |
Operating Systems

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>

Documentation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td>You can now access SAP Notes directly in SAP Service Marketplace from your PDF. Place the cursor on the SAP Note &quot;&lt;number&gt;&quot; and double-click. A separate browser window opens and the SAP Note is displayed.</td>
</tr>
</tbody>
</table>
| Links to the Internet | You can use the new links in the PDF files of the guides as follows:  
  - Click on the section headings such as New Features to jump back to the table of contents at the beginning of the guide.  
  - Click on an internet link such as [http://service.sap.com](http://service.sap.com) to jump to the corresponding internet page. |

1.2 SAP Notes for the Installation

You **must** read the following SAP Notes **before** you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note which you can find in the SAP Service Marketplace at [http://service.sap.com/notes](http://service.sap.com/notes).

SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>965569</td>
<td>SAP NetWeaver Installation Based On Kernel 7.0: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
<tr>
<td>953763</td>
<td>Installation of SAP NetWeaver Composition Environment 7.1</td>
<td>CE-specific information about the installation and corrections to this documentation.</td>
</tr>
</tbody>
</table>
1.3 Information Available on SAP Service Marketplace

More information is available as follows on SAP Service Marketplace.

Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation of SAP Solution Manager</td>
<td>[<a href="http://service.sap.com/solutionmanager%5C">http://service.sap.com/solutionmanager\</a>] [Installation Guides] [Release 4.0]</td>
<td>Installation Guide – SAP Solution Manager 4.0 on &lt;OS&gt;: &lt;Database&gt;</td>
</tr>
<tr>
<td>Configuration of SAP Solution Manager</td>
<td>[<a href="http://service.sap.com/solutionmanager%5C">http://service.sap.com/solutionmanager\</a>] [Installation Guides] [Release 4.0]</td>
<td>Configuration Guide – SAP Solution Manager 4.0 on &lt;OS&gt;: &lt;Database&gt;</td>
</tr>
<tr>
<td>Maintenance Optimizer</td>
<td>[<a href="http://service.sap.com/solutionmanager%5C">http://service.sap.com/solutionmanager\</a>] [Functions in Detail] [Support Area] [Maintenance Optimizer]</td>
<td>All corrective software packages, including Support Packages (Stacks) for SAP NetWeaver 7.0 (2004s) and subsequent versions, as well as all applications which are based on this software (including SAP Business Suite 2005), released after April 2, 2007, will be available exclusively through the Maintenance Optimizer in SAP Solution Manager.</td>
</tr>
</tbody>
</table>
1.4 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**

- **SAP system** refers to SAP NetWeaver CE 7.1.

**Variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;sapid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;sid&gt; and &lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;DBSID&gt;</td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;dbsid&gt;</td>
<td>Database ID in lowercase letters</td>
</tr>
</tbody>
</table>
**1.4 Naming Conventions**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;host_name&gt;</code></td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td><code>&lt;INSTDIR&gt;</code></td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td><code>&lt;DVD_DIR&gt;</code></td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td><code>&lt;OS&gt;</code></td>
<td>Operating system name within a path</td>
</tr>
<tr>
<td><code>&lt;SCHEMAID&gt;</code></td>
<td>Database schema ID</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapsid>adm` and change to the directory `/usr/sap/<SAPSID>`.
If your SAP system ID is C11, log on as user `c11adm` and change to the directory `/usr/sap/C11`. 
2 Planning

This section provides general planning information.

You must first:
1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 13].

Now continue with the section for your chosen installation option below.

Standard, Distributed, or High-Availability System

1. For the database installation, you decide on how to distribute your database components to disk [page 18].
2. You decide on the transport host to use [page 21].
3. If you want to use Adobe Document Services (ADS), you check what you have to do in case your platform is not supported for ADS [page 22].
4. You decide whether you want to install the database for multiple components with MS SQL Server [page 22] or whether you want to install multiple components in one database (MCOD) [page 24].

Only valid for: HA (MSCS)

5. If you want to install a high-availability system with Microsoft Cluster Service (MSCS), see the MSCS-specific planning activities [page 115].

End of: HA (MSCS)

6. You can now continue with Preparation [page 27].

Additional Application Server Instance
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 27]

Host Agent as a Separate Installation
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 27]

2.1 Installation Options Covered by this Guide
This section shows the installation options covered by this installation guide. In the SAPinst tool, these comprises installation and software life-cycle options.
2 Planning
2.1 Installation Options Covered by this Guide

- **Standard system** [page 14] (formerly known as central system)
- **Distributed system** [page 15] (Only valid for HA (MSCS))
- **High-availability system** [page 15] (End of: HA (MSCS))

- You can install one to <n> additional application server instance(s) [page 16] to an existing standard, distributed or high-availability system.
- You can install a standalone host agent [page 17].

### 2.1.1 Standard System

You can install a standard system on a single host.

In a standard system, all main instances run on a single host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

**Figure 1: Standard System**

```
Host with PAS, SCS and DB

SCS
PAS

DB

Java Schema

SCS = Java central services instance
PAS = Primary application server instance
DB = Database instance
```

Optionally you can install one to <n> additional application server instances. For more information, see *Additional Application Server Instance* [page 16].
2.1.2 Distributed System

In a distributed system, every instance can run on a separate host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

Optionally you can install one to <n> additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 16].

**Figure 2:** Distributed System

SCS = Java central services instance  
PAS = Primary application server instance

Only valid for: HA (MCS)

2.1.3 High Availability System

For more information on the system components you have to install and how to distribute them on the specific hosts, see System Configuration in MCS [page 115].
2.1.4 Additional Application Server Instance

You can install one to \(<n>\) additional application server instance(s) for an existing SAP system. An additional application server instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

Note

It is not recommended to install additional application server instance(s) on the SAP global host.

Additional Application Server Instance for a Standard System

The following figure shows additional application server instances that are running on dedicated hosts.

Figure 3: Additional Application Server Instance for a Standard System

For additional information, see Standard System [page 14].

Additional Application Server Instance for a Distributed System

The following figure shows additional application server instances that are running on dedicated hosts.
For additional information, see Distributed System [page 15].

Additional Application Server Instance for a High-Availability System

In a high-availability system, you require besides the primary application server instance, at least one additional application server instance. For more information about how to install and distribute the application servers in an MBCS configuration, see section System Configuration in MBCS [page 115].

End of: HA (MBCS)

2.1.5 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components.

You only need to install a standalone host agent in the following cases:

- You want to centrally monitor a host that does not have an SAP component.
- You want to perform an upgrade to SAP NetWeaver.
2.2 Distribution of SAP System Components to Disks

When you install the SAP system, the main directories required for the system are automatically created. However, during the installation procedure, SAPinst prompts you to enter drive letters for the main components of the system. This gives you the opportunity to distribute components to
disks in the system as you wish. The way in which you do this significantly affects system throughput and data security, and must therefore be carefully planned. The best distribution depends on your specific environment and must take into consideration factors such as the size of the components involved, security requirements and the expected workload.

When you work out the assignment of components to disks, you first need to get an overview of the main components and their corresponding directories. Then, on the basis of sample configurations and the recommendations provided in this documentation, you can decide which assignment is best for your particular system.

The following table gives you an overview of the main SAP system components, directories, and their purpose.

A good distribution of these to disks ensures that:

- Enough free space is available for system growth
- The data is secure
- Performance is good

<table>
<thead>
<tr>
<th>Directory Type</th>
<th>Directory Structure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System</td>
<td></td>
<td>SAP kernel and related files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SAP transport directory</td>
</tr>
<tr>
<td>Database Management System (DBMS)</td>
<td></td>
<td>SQL Server program files including</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the master, msdb and model database</td>
</tr>
<tr>
<td></td>
<td></td>
<td>files.</td>
</tr>
<tr>
<td>SAP Database</td>
<td></td>
<td>Database data files &lt;0-N&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tempdb</td>
<td></td>
<td>Tempdb data files</td>
</tr>
</tbody>
</table>

**Database Components**

When you install an SAP system with MS SQL Server, the central components of the database are the SQL Server program files, tempdb files, SAP database data files and SAP database transaction log files. The log files record all the changes made to the database to enable restore and recovery. The tempdb holds all temporary tables and stored procedures. The data files contain the data for the SAP system.
SAP Database Data Files

The data files are created by default in the directories `<SAPSID>DATA<n>` on the disk with the most free available space. The first data file is called `<SAPSID>DATA0.mdf` and subsequent files `<SAPSID>DATA<n>.ndf`, where `<n>` denotes the number of the file.

For performance reasons, locate the data files on a separate disk system. They should not be included in the same disk system as the log files or other SQL Server program and database files. To ensure data redundancy, SAP recommends the use of RAID 5.

Transaction Log File

The transaction log for the database is created by default in the directory `<SAPSID>LOG1` on the disk with the most free available space. The log file is called `<SAPSID>LOG1.1df`.

The transaction log file records all the changes made to the database and, if required, enables modifications to be redone or undone. It plays a crucial role when the database has to be restored due to database damage or media failure.

SAP recommends the use of RAID 1 which implements hardware-based mirroring.

Program Files

The files other than the SAP database data and transaction log files are created in the subdirectories of `\Program Files\Microsoft SQL Server`. These include the SQL Server program files and the `master.mdb` and `model1` database files.

Locate these on a separate, third, disk system and not on the same disks as the transaction log files or SAP database data files. SAP recommends the use of RAID 1.

For performance reasons, it is advisable to place the `tempdb` files on a fast disk system. This is particularly recommended because the `tempdb` is frequently accessed during SQL Server operation and could otherwise affect performance.

Note

After the initial installation of the database software, the `tempdb` is located in a subdirectory of `\Program Files\Microsoft SQL Server`. However later, when SAPinst builds and loads the database, it is transferred to a new `\TEMPDB` directory and extended to a size of 300 MB.

Distribution of Main Directories to RAID Array

The following graphic illustrates how the main directories that are created during the installation can be distributed to RAID arrays. The distribution is suitable for an average-sized production system.

Keep in mind that this is only an example and that no single solution is fitting for all environments.

Note

The SAP kernel files and the transport directory can be assigned to any of the arrays depicted, but must both be located on the same array. The transport directory does not necessarily have to reside on the primary application server instance host.
### 2.3 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary.

---

**Figure 6:** Distribution of SAP System Components to RAID Arrays

<table>
<thead>
<tr>
<th>Array 1</th>
<th>\Program files\Microsoft SQL Server \TEMPDB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array 2</td>
<td>&lt;SAPSID&gt;DATA0&lt;br&gt;&lt;SAPSID&gt;DATA1&lt;br&gt;&lt;SAPSID&gt;DATA2&lt;br&gt;&lt;SAPSID&gt;DATA3&lt;br&gt;...&lt;br&gt;&lt;SAPSID&gt;DATA&lt;N&gt;</td>
</tr>
<tr>
<td>Array 3</td>
<td>&lt;SAPSID&gt;log1</td>
</tr>
</tbody>
</table>

**Optimizing Performance**

If you wish to optimize performance, isolate the tempdb on a separate, fast disk. This improves performance significantly because the tempdb is continually accessed during MS SQL Server operation. A further option for improving performance is to place the Windows paging file on a separate, fast disk.
data, or customization data. If you have several SAP systems they are usually organized in transport
domains. In most cases, all SAP systems in a transport domain have a common transport directory.
For more information, see:
Operations Manual > General Administration Tasks > Software Life Cycle Management > Software Logistics
> Change and Transport System > Change and Transport System – Overview (BC-CTS) > Basics of the Change and Transport
System > Transport Management System — Overview

When you install an SAP system, SAPinst by default creates the transport directory on the primary
application server instance host in \usr\sap\trans.

Only valid for: HA (MSCS)

Note
In an MSCS configuration, SAPinst by default creates the transport directory on the (ABAP) central
services instance host in \usr\sap\trans.

End of: HA (MSCS)

If you want to locate the transport directory on another host, or if you want to use an already existing
transport host and directory in your SAP system landscape, you have to prepare this host for use by
the new SAP system. For more information, see Preparing the SAP System Transport Host [page 53].

More Information
SAP Directories [page 96]

2.4 Running Adobe Document Services on Non-Supported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms
supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure
To use ADS in SAP landscapes on non-supported platforms, install an additional standalone AS
Java on a platform supported by ADS.
For more information, see SAP Note 925741.

2.5 Database Installation for Multiple Components with MS SQL Server

Each SAP system in your mySAP environment needs its own database back end. With MS SQL Server
you have the following options to distribute your systems across the available hardware resources.
They differ with respect to hardware requirements, database administration, flexibility, and scalability, but all require careful hardware sizing to avoid performance bottlenecks and scalability problems.

- **Exclusive database server**
  In this system landscape, each database server (with or without a primary application server instance) hosts exactly one SAP database. From an installation planning perspective, this is the simplest solution. It is the most scalable setup, but it requires the most hardware. This option is typically chosen for medium-sized and large production and development systems.

- **Named SQL Server instances**
  With the use of named instances, you can install multiple, independent SQL Server instances on a single database server. These instances share CPU, memory and disk resources, but from an administration point of view are completely independent from each other.

- **Multiple databases in an SQL Server instance**
  SQL Server lets you operate multiple user databases in a single SQL Server instance. Contrary to named instances, the databases share the temporary system database `tempdb`, the SQL Server Windows process, and the SQL Server memory pool. Therefore, this setup is less scalable than named instances, but at the same time requires less system resources. It can be a flexible solution for small and medium-sized systems.

- **Multiple Components in One Database (MCOD)**
  Multiple database back ends are stored in the same database, each in its own database schema. For the database administrator, the database containing these multiple components looks very much like a single entity. While this approach is not as flexible as the other options, its simplicity makes it an attractive solution for small mySAP environments.

**More Information**

- Default or Named MS SQL Server Instances [page 23]
- Multiple Components in One Database (MCOD) [page 24]

### 2.5.1 Default or Named MS SQL Server Instances

When you install MS SQL Server, you can install two different types of instances:

- Default instance
- Named instance

When you plan your system configuration, you must decide which instance type you want to install. The following clarifies the difference between the two.

**Default Instance**

A default instance is the most common form of an MS SQL Server installation in an SAP environment. Typically, one MS SQL Server instance is installed together with a single SAP database.
In this configuration, all MS SQL Server components and functionality are exclusively available for the SAP database.

In a less frequently implemented configuration, a single MS SQL Server instance is installed together with more than one SAP database on the same computer. In this type of configuration, the MS SQL Server components such as executables, system databases and utilities exist only once and have to be shared by all SAP databases. As all the databases on the computer have to be managed with a single copy of the MS SQL Server, certain administrative tasks on one database cannot be performed in isolation without affecting the other databases.

A default instance is recommended, if you plan to install only one SAP database instance on a computer.

**Named Instance**

The advantage of named instances is that you can set up several SAP databases on the same machine and administer each one separately with its own copy of the MS SQL Server. The main components of the MS SQL Server are available exclusively for each instance and can be used only by that instance. Only a few resources such as client utilities have to be shared by all the instances because they are only installed once. During the installation, each named instance is given a name that is the same as the SAP system name, thus enabling a unique assignment of instances to SAP databases.

Several named instances and the default instance can coexist on the same computer and function in isolation of each other.

A named instance is recommended, if you plan to install more than one SAP database instance on the same machine.

### 2.6 Installation of Multiple Components in One Database

You can install **multiple** SAP systems in a **single** database. This is called Multiple Components in One Database (MCOD).

MCOD is available with all SAP components. We are releasing this technology on all the major databases for the SAP system, in line with our commitment to deliver platform-independent solutions.

Using this technology is as easy as installing a separate component. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

With MCOD we distinguish two scenarios:

- The installation of an SAP system in a new database
The installation of an additional SAP system in an existing database

**Prerequisites**

- For more information on MCOD and its availability on different platforms, see the SAP Service Marketplace at [http://service.sap.com/mcod](http://service.sap.com/mcod).
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required
  
  In general, you calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. The same applies to memory resources and disk space.
  
  You can size multiple components in one database by sizing each individual component using the SAP Quick Sizer and then adding the requirements together. For more information on the SAP Quick Sizer, see the SAP Service Marketplace at [http://service.sap.com/sizing](http://service.sap.com/sizing).

**Features**

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  
  In an MCOD landscape you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

**Note**

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

**Constraints**

- **We strongly recommend** that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  
  - Copying a single component from an MCOD landscape to another database at database level is not possible. You have to perform a homogeneous system copy with R3load instead.
De-installing a single component from an MCOD landscape requires some additional steps. You can use a remote connection to SAP support to request help with these tasks. For more information see http://service.sap.com/remoteconnection.

**MSCS only**: The installation of multiple components in one database with Microsoft Cluster Service (MSCS) **must** be performed by an SAP Global Technology Partner who supports any installation and configuration problems that arise from this configuration. For more information on MSCS, see Microsoft Cluster Installation.

For the first SAP system, the DBSID must be the same as for the first SAP system installed in this database.

For the second SAP system, you must use the same DBSID as for the first SAP system.

As SAPinst turns off database logging during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Standard, distributed, or high-availability system
- Additional application server instance
- Host agent

**Standard, Distributed, or High-Availability System**

Note
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You identify basic SAP system parameters [page 28].
2. You check the hardware and software requirements [page 34] on each host.
3. You check the Windows file system [page 48] on each host.
4. You check that all installation hosts belong to the correct Windows domain [page 48].
5. You reduce the size of the file cache [page 49] on each host.
6. You check that you have the required user authorization for the installation [page 49].
7. If required, you perform a domain installation without being a domain administrator [page 51].
8. If required, you prepare the SAP system transport host [page 53] for your SAP system.
9. You make sure that the required installation media [page 56] is available on each host.

For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you also have to perform MSCS-specific preparation tasks [page 132].

10. You can now continue with Installation [page 59].

**Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You check the hardware and software requirements [page 34].
2. You check the Windows file system [page 48].
3. You check that your host belongs do the correct Windows domain [page 48].
4. You reduce the size of the file cache [page 49].
5. You check that you have the required user authorization for the installation [page 49].
6. If required, you perform a domain installation without being a domain administrator [page 51].
7. You make sure that the required installation media [page 56] is available.
8. You can now continue with Installation [page 59].

Standalone Host Agent
You have to perform the following preparations on the host where you install the host agent separately:
1. You identify basic SAP system parameters [page 28].
2. You check the hardware and software requirements [page 34].
3. You check the Windows file system [page 48].
4. You reduce the size of the file cache [page 49].
5. You check that you have the required user authorization for the installation [page 49].
6. If required, you perform a domain installation without being a domain administrator [page 51].
7. You make sure that the required installation media [page 56] is available.
8. You can now continue with Installation [page 59].

3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode. If you choose Typical, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.

The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode. For all other SAP system parameters, use the [F1] help in the SAPinst dialogs.

**SAP System ID and Database ID**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts you for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory. Example: This prompt appears when you install the central services instance, which is the</td>
</tr>
</tbody>
</table>
### 3.1  Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID &lt;DBSID&gt;</td>
<td>The &lt;DBSID&gt; identifies the database instance. SAPinst prompts you for the &lt;DBSID&gt; when you are installing the database instance. The &lt;DBSID&gt; can be the same as the &lt;SAPSID&gt;.</td>
</tr>
</tbody>
</table>

**Caution**

Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

**If you want to install a new database:**

- Make sure that your database ID:
  - Is unique throughout your organization
  - Consists of exactly three alphanumeric characters
  - Contains only uppercase letters
  - Has a letter for the first character
  - Does not include any of the following, which are reserved IDs: ADD ALL AND ANY ASC COM CON DBA END EPS FOR GID IBM INT KEY LOG MON NIX NOT NUL OFF OMS RAW ROW SAP SET SGA SHG SID SQL SYS TMP UID USR VAR

**If you want to use an existing database:**

Enter exactly the database ID of the existing database to which you want to add the system.
SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;lt;SAPGLOBALHOST&gt;\sapmnt&amp;lt;SAPSID&gt;\SYS\profile</td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPInst prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
</tbody>
</table>

**Note**

If you install an additional application server instance to an existing SAP system, SAPInst also prompts you for the profile directory of the existing SAP system.

SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Instance Number | **Instance Number:**
Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97.
The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers.
To find out this number, look in the SAP directory &lt;Drive&gt;:\usr\sap\&lt;SAPSID\>&lt;nn&gt; on the host of the primary application server instance.
The value &lt;nn&gt; is the number assigned to the primary application server instance.

**Caution**

Do not use 43, 60, 89 for the instance number because:

- 43 is used by MSCS
- 60 is used by iSCSI
- 89 is used by Windows Terminal Server

| Virtual Host Name | For a high-availability (HA) system you need to specify the virtual host name, which is used by the (A)SCS instance.
- For more information about the use of virtual TCP/IP host names, see SAP Note 962955.
- For more information about the allowed host name length and characters, see SAP Note 611361.
To find out the host name, open a command prompt and enter hostname. |

| Message Server Port | **Caution**
The message server port number must be unique for the SAP system on all hosts. If there are several message ports number on one host, all must be unique.

**Port Number of the SAP Message Server:**
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mas</strong></td>
<td>If you do not specify a value, the default port number is used. The Java message server is configured in the SCS instance profile. The Java message server port uses the parameter <em>rdismp/mssrv_internal</em> with default value 39&lt;nn&gt;, where &lt;nn&gt; is the instance number of the SCS message server instance. For more information about the parameters used for message server ports, see SAP Note <a href="#">821875</a>.</td>
</tr>
</tbody>
</table>

Parameters for SAP System Drives

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Destination drive | Base directory for the SAP system.  

**Note**  
If you install a subsequent SAP system, the sap10c share already exists and you cannot select the installation drive. SAPInst uses the installation drive where the sap10c share points to. |

Master Password

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Master Password | This password is used for all new user accounts SAPInst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.  

**Caution**  
If you do not create the operating system users manually, SAPInst creates them with the common master password. For more information, see the description of the parameter *Operating System Users*. In this case, make sure that the master password meets the requirements of your operating system and of your database. |

Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Password of Operating System Users | SAPInst processes the passwords of operating system users as follows:  
- If the operating system users do **not** exist, SAP creates the following users:  
  - `<sapsid>adm`  
    This user is the SAP system administrator user and is a member of the local **Administrators** group.  
  - SAPService `<SAPSID>`  
    This user is the Windows account to run the SAP system. It is not a member of the local **Administrators** group. |
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sapadm</code></td>
<td>The host agent user <code>sapadm</code> is used for central monitoring services and is a member of the local <code>Administrators</code> group. SAPinst sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode <code>Custom</code> or by changing them on the parameter summary screen. If the operating system users already exist, SAPinst prompts you for the existing password, except the password of these users is the same as the master password.</td>
</tr>
</tbody>
</table>

⚠️ **Caution**

Make sure that you have the *required user authorization* [page 49] for these accounts before you start the installation.

---

### User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UME Configuration</td>
<td>SAPinst prompts you for how to configure the UME during the input phase of the installation. You can choose between the following options: Use Java database (default). If you choose this option, administrators can manage users and groups with the <strong>UME Web admin</strong> tool and <strong>SAP NetWeaver Administrator</strong> only. Use an external ABAP system. If you choose this option, administrators can manage users with the transaction SU01 on the external ABAP system, and, depending on the permissions of the communication user, also with the <strong>UME Web admin</strong> tool and <strong>SAP NetWeaver Administrator</strong>. You must have created the required users manually on the external ABAP system. For more information, see <em>Preparing User Management for an External ABAP System</em> [page 45].</td>
</tr>
</tbody>
</table>

#### Using the Java Database:

<table>
<thead>
<tr>
<th>Java Administrator User</th>
<th>SAPinst sets the user name <code>Administrator</code> and the master password by default. If required, you can choose another user name and password according to your requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Guest User</td>
<td>SAPinst sets the user name <code>Guest</code> and the master password by default. The <code>Guest</code> user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <code>Authenticated Users</code> and have read access only.</td>
</tr>
</tbody>
</table>

#### Using an External ABAP System – Parameters for the ABAP Connection:
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Instance Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look under the SAP directory <code>usr/sap/&lt;SAPSID&gt;/DVEBMGS&lt;nn&gt;</code>. The value <code>&lt;nn&gt;</code> is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <code>hostname</code> at the command prompt of the host running the primary application server instance.</td>
</tr>
<tr>
<td>Communication User</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Using an External ABAP System – Parameters for the Application Server Java Connection:**

- **Administrator User**
  
  This is the name and password of the administrator user that you created on the external ABAP system.

- **Administrator Role**
  
  The role `SAP_J2EE_ADMIN` must exist on the external ABAP system.

- **Guest User**
  
  This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group `Authenticated Users` and have read access only.

- **Guest Role**
  
  The role `SAP_J2EE_GUEST` must exist on the external ABAP system.

**Internet Communication Manager (ICM) User Management**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <code>webadm</code></td>
<td>The administration user <code>webadm</code> is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. <code>SAPinst</code> sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

**Host Agent as a Separate Installation**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <code>sapadm</code></td>
<td>The administration user <code>sapadm</code> is created to use central monitoring services. If this user is not already existing, it is created automatically by <code>SAPinst</code>. <code>SAPinst</code> prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>
3.2 Hardware and Software Requirements

You check the hardware and software requirements for your operating system (OS) and the SAP instances using the Prerequisite Checker tool that provides information about the requirements that you need to meet before you start the installation. For example, it checks the requirements for the different installation options.

Note

- The values that are checked by the Prerequisite Checker apply to the installation of development systems or quality assurance systems.
- For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

You can run the Prerequisite Checker as follows:

- Standalone (optional):
  To check the hardware and software requirements of the host on which you want to later install an SAP system, you can run the Prerequisite Checker standalone [page 36].
- Integrated in SAPinst (mandatory):
  SAPinst automatically runs the Prerequisite Checker when you install your SAP system.

Recommendation

We also recommend that you consult the requirements checklists tables, which also provide values for the installation of development systems or quality assurance systems. Depending on the amount of data involved, the requirements might change.
In addition, consider the following information:

- To get precise sizing values for **production systems**, you choose one of the following options:
  - You use the **SAP Quick Sizer** tool that is available on SAP Service Marketplace at [http://service.sap.com/sizing](http://service.sap.com/sizing). You enter information about your planned system and the tool calculates the requirements.
  
  For more information, see **Planning your System Landscape** in the **Master Guide** for your SAP system, which is available on SAP Service Marketplace [page 10].

  - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:

    - The set of applications to be deployed
    - How intensively the applications are to be used
    - The number of users

- For supported operating system releases, see the **Product Availability Matrix** on SAP Service Marketplace at [http://service.sap.com/pam](http://service.sap.com/pam).

- Contact your OS vendor for the latest OS patches.

- Make sure that the host name meets the requirements listed in **SAP Note 61361**.

### Process Flow

1. If required, you run the **Prerequisite Checker standalone** [page 36] to check the hardware and software requirements.

   ![Caution]

   *If you do not fully meet the requirements, you might experience problems when working with the SAP system.*

2. In addition, we recommend that you check the hardware and software requirements checklists for the following system variants:
   - **Standard system** [page 36]
   - **Distributed system** [page 38]

   ![Only valid for: HA (MSCS)]

   **High-Availability System with MSCS** [page 40]

   ![End of: HA (MSCS)]

   - Additional application server instance
   - If you want to install an additional application server instance, check the requirements listed for a **distributed system** [page 38].

   - Application Sharing Server as an Optional Standalone Unit
   - If you want to install the Application Sharing Server as a standalone unit, you must meet the same requirements than for a **Java standard system** [page 36].

   - **Standalone Host Agent** [page 44]
3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

Recommendation

We recommend that you use both the Prerequisite Checker and the requirements tables for reference.

Note

When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

Prerequisites

- You have prepared the Installation Master DVD on the required installation host [page 56].

Procedure

1. You start SAPinst [page 66].
2. On the Welcome screen, choose <SAP System> Software Life-Cycle Options Additional Preparation Tasks Prerequisites Check.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

Note

For more information about each parameter, position the cursor on the parameter field and choose F1 in SAPinst.

When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.
4. To start the Prerequisite Checker, choose Start.

Result

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.

3.2.2 Requirements for a Standard System

If you want to install a standard system, where all instances reside on one host, this host must meet the following hardware and software requirements:
### Hardware Requirements for a Standard System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Database Software: 4 GB&lt;br&gt;- SAP system files (not including paging file): 5 GB (x86_64)&lt;br&gt;8 GB (IA64)&lt;br&gt;- SAP database files (not including paging file): 3 GB&lt;br&gt;- Up to 2 GB for each usage type or software unit you want to install.&lt;br&gt;- 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk</td>
<td>To check disk space:&lt;br&gt;1. Choose Start &gt; All Programs &gt; Administrative Tools &gt; Computer Management &gt; Disk Management.  &lt;br&gt;2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1.5 GB</td>
<td>To check RAM:&lt;br&gt;In the Windows Explorer choose Help &gt; About Windows.</td>
</tr>
<tr>
<td>Paging file size</td>
<td>1 times RAM plus 8 GB</td>
<td>To check paging file size:&lt;br&gt;1. Right-click My Computer and choose Properties.&lt;br&gt;2. Choose Advanced &gt; Performance Settings.  &lt;br&gt;3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td>--</td>
</tr>
</tbody>
</table>

### Software Requirements for a Standard System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database software</td>
<td>- MS SQL Server 2005 Enterprise Edition: Server Software (English version)&lt;br&gt;- Latest service pack and hotfix, if available. For more information, see <strong>SAP Note 62988</strong>.&lt;br&gt;- Unicode collation SQL_Latin1_General_CP850_BIN2</td>
<td>--</td>
</tr>
</tbody>
</table>
### 3.2.3 Requirements for a Distributed System

This section provides information about the hardware and software requirements in a distributed system, where the SAP instances can reside on different hosts.

The tables show the requirements for the:
- **Central services instance**
- **Database instance**
- **Primary application server instance**
- **Additional application server instance**

**Note**

- The listed values only apply for development systems or quality assurance systems.
- If you install several SAP instances on one host, you need to add up the requirements.

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Minimum disk space   | - Database Software: 4 GB  
                       | - Central services instance (SCS) (not including paging file): 5 GB (x86_64) 8 GB (IA64)  
                       | - SAP database instance (not including paging file): 3 GB  
                       | - Primary application server instance (not including paging file): 5 GB (x86_64) 8 GB (IA64)  
                       | - In addition you require 4 GB (x86_64), or 8 GB (IA64) per additional platform.  
                       | - Up to 2 GB for each usage type or software unit you want to install.  
                       | - Additional application server instance (not including paging file): 2.5 GB (x86_64) 5 GB (IA64)  
                       | - Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB  
                       | To check disk space:  
                       | 1. Choose Start All Programs Administrative Tools Computer Management Disk Management.  
                       | 2. Right-click the drive and choose Properties. |
## 3.2 Hardware and Software Requirements

### Hardware Requirement

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM: In the Windows Explorer, choose [Help] &gt; About Windows.</td>
</tr>
<tr>
<td>Paging file size</td>
<td></td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Right-click My Computer and choose Properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td>English international 64-bit version of one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Datacenter Edition</td>
</tr>
<tr>
<td></td>
<td>- For any version of Windows Server 2003, you need at least service pack 2.</td>
</tr>
<tr>
<td></td>
<td>- A suitable Windows Resource Kit is strongly recommended.</td>
</tr>
<tr>
<td>Database software</td>
<td>Central services instance (SCS):</td>
</tr>
<tr>
<td></td>
<td>- MS SQL Server 2005 Native Access Client (SNAC) software</td>
</tr>
<tr>
<td></td>
<td>- Latest service pack and hotfix, if available. For more information, see SAP Note 62988.</td>
</tr>
<tr>
<td></td>
<td>- Database instance:</td>
</tr>
<tr>
<td></td>
<td>- MS SQL Server 2005 Enterprise Edition: Server Software (English version)</td>
</tr>
<tr>
<td></td>
<td>- Latest service pack and hotfix, if available. For more information, see SAP Note 62988.</td>
</tr>
<tr>
<td></td>
<td>- Unicode collation</td>
</tr>
<tr>
<td></td>
<td>- SQL_Latin1_General_CP850_BIN2</td>
</tr>
<tr>
<td></td>
<td>- Primary application server instance:</td>
</tr>
<tr>
<td></td>
<td>- MS SQL Server 2005 Native Access Client (SNAC) software</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Software Requirements for a Distributed System

To check your Windows version:
2. Enter the command `winver`. 
### 3.2.4 Requirements for a High-Availability System

This section provides information about the hardware and software requirements in a high-availability system.

**Note**

1. You must check that your cluster hardware is certified.
   AddOn Technology Center for SAP (Add On TCS) certifies hardware platforms for SAP on Microsoft Windows. The cluster must be included in the Microsoft list of certified clusters and its components. You can access the lists at the following Internet addresses:
   - [www.microsoft.com/whdc/hcl/default.mspx](http://www.microsoft.com/whdc/hcl/default.mspx)
   - [www.saponwin.com](http://www.saponwin.com)

2. You must make sure that the MSCS nodes of the cluster are connected by a private and public network:
   - The public network enables communication from the MSCS nodes of the cluster to other resources in the local area network (LAN).
   - The private network enables internal communication between the MSCS nodes. In particular, it enables the Cluster Service running on all MSCS nodes to regularly exchange messages on the state of the MSCS nodes so that the failure of resources is quickly detected.

3. Each of the MSCS nodes in the cluster must have its own local disks and have access to shared disks that can be reached by the MSCS nodes via a shared bus.
   All software — except the Windows operating system, the MS SQL server binaries, and the MSCS software — is stored on the shared disks.
   One of the shared disks must be used exclusively by the quorum (if a single quorum device cluster is used) that stores the cluster registry and records information about the state of the cluster.
   You require at least 4 shared disks.

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Latest service pack and hotfix, if available. For more information, see SAP Note 62988.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Additional application server instance:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- MS SQL Server 2005 Native Access Client (SNAC) software</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Latest service pack and hotfix, if available. For more information, see SAP Note 62988.</td>
<td></td>
</tr>
</tbody>
</table>

Only valid for: HA (MSCS)
3.2 Hardware and Software Requirements

For more information about the distribution of components to local and shared disk, see Distribution of Components to Disks for MSCS [page 123].

**Caution**

- All disk controllers must be able to support hardware-based RAID.
- You **cannot** use a host with a domain controller as an MSCS cluster node.

The following tables show the hardware and software requirements for the:

- Central services instance (SCS)
- Database instance
- Enqueue Replication Server instance (ERS)
- Primary application server instance
- Additional application server instance

The listed values only apply for development systems or quality assurance systems.

**Caution**

- If you install several SAP instances on one host, you need to add up the requirements.
- If you install multiple SAP systems in one MS cluster, make sure that together with your hardware partner you have set up the correct sizing for your system configuration.

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Database Software: 4 GB&lt;br&gt;- Central services instance (SCS) (not including paging file): 5 GB (x86_64) 8 GB (IA64)&lt;br&gt;- SAP database instance (not including paging file): 3 GB&lt;br&gt;- Enqueue replication server instance (ERS) (not including paging file): 5 GB (x86_64) 8 GB (IA64)&lt;br&gt;- Primary application server instance (not including paging file): 2.5 GB (x86_64) 5 GB (IA64)</td>
<td>To check disk space:&lt;br&gt;1. Choose <strong>Start ➤ All Programs ➤ Administrative Tools ➤ Computer Management ➤ Disk Management.</strong>&lt;br&gt;2. Right-click the drive and choose <strong>Properties.</strong></td>
</tr>
</tbody>
</table>

11/05/2007 PUBLIC 41/164
### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
</tr>
</tbody>
</table>
| Paging file size       | Central services instance (SCS): 1 times RAM plus 8 GB                      | To check paging file size:  
1. Right-click My Computer and choose Properties.  
2. Choose Advanced Performance Settings.  
3. If required, in section Virtual Memory, choose Change. |
| Suitable backup system |                                                                             | –                                                                        |

### Software Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system | **English international 64-bit version** of one of the following:  
3. For any version of Windows Server 2003, you need at least service pack 2.  
4. A suitable Windows Resource Kit is strongly recommended. |
|                      | To check your Windows version:  
1. Choose Start All Programs Accessories Command Prompt.  
2. Enter the command winver. |

**Note**
You must set up the MSCS Cluster Service as described in the Microsoft documentation. During this setup you are asked for a Windows Domain Account to run the Cluster Service. We strongly recommend creating an account different from the <sapsid>adm user, for example...
## 3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| **Database software** |  - ABAP central services instance (ASCS):  
  - MS SQL Server 2005 Native Access Client (SNAC) software  
  - Latest service pack and hotfix, if available. For more information, see SAP Note 62988.  
  - Central services instance (SCS):  
    - MS SQL Server 2005 Native Access Client (SNAC) software  
    - Latest service pack and hotfix, if available. For more information, see SAP Note 62988.  
  - Database instance:  
    - MS SQL Server 2005 Enterprise Edition: Server Software (English version)  
    - Latest service pack and hotfix, if available. For more information, see SAP Note 62988.  
    - Unicode collation  
      SQL_Latin1_General_CP850_BIN2  
  - Primary application server instance:  
    - MS SQL Server 2005 Native Access Client (SNAC) software  
    - Latest service pack and hotfix, if available. For more information, see SAP Note 62988.  
  - Additional application server instance:  
    - MS SQL Server 2005 Native Access Client (SNAC) software  
    - Latest service pack and hotfix, if available. For more information, see SAP Note 62988. | `ClusterServiceuser=saprdcladm, where Clustername=saprdcl.` |
### 3.2.5 Requirements for the Host Agent as a Separate Installation

If you want to install the host agent separately, the installation host has to meet the following hardware and software requirements:

#### Hardware Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>Host agent:</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td>Minimum RAM:</td>
<td>40 MB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the Windows Explorer choose Help &gt; About Windows.</td>
</tr>
<tr>
<td>Paging file size</td>
<td>500 MB</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Right-click My Computer and choose Properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Choose Advanced &gt; Performance Settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td>--</td>
</tr>
</tbody>
</table>

#### Software Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td>English international 64-bit version of one of the following:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For any version of Windows Server 2003, you need at least service pack 2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A suitable Windows Resource Kit is strongly recommended.</td>
<td></td>
</tr>
<tr>
<td>Database software</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>
3.3 Preparing User Management for an External ABAP System

For a Java system, you can also deploy user management for an external ABAP system. In this case, you configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system.

You can take one of the following approaches:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
</tbody>
</table>
| All Java systems use the same configuration | You create the users only once and enter the same information for every Java systems that you install. | Interdependencies between the connected engines:  
  - If you change the password of any of the users on the ABAP system, this change affects all connected engines.  
  - If you change the administrator user’s password, you must also change the password in secure storage on all of the connected Java systems. |

**Recommendation**

For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

**Prerequisites**

- The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.
- In transaction PFCG, check that the roles `SAP_BC_JSF_COMMUNICATION` and `SAP_BC_JSF_COMMUNICATION_RO` exist and make sure that their profiles are generated.
- In transaction PFCG, check that the roles `SAP_J2EE_ADMIN`, `SAP_J2EE_GUEST` and `SAP_BC_FP_ICF` exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
- In transaction PFCG, create a role named `A0SCallers`. You do not need to maintain authorization data or generate any profiles for that role.
- For more information, see:  
  - `<your product>`  
  - SAP NetWeaver Library  
  - Function-Oriented View  
  - Security  
  - Identity Management  
  - Identity Management of the Application Server Java  
  - User Management Engine.
3.4 Preparing User Management for an External ABAP System

Note
For more information about role maintenance, see the SAP Library at

Administration of the ABAP system
Perform the following administration steps in the ABAP system:

1. In transaction SU01 create a new communication user and assign it to the role SAP_BC_JSF_COMMUNICATION_RO.

   Recommendation
   We recommend that you assign this user the role SAP_BC_JSF_COMMUNICATION_RO for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role SAP_BC_JSF_COMMUNICATION instead.
   
   We recommend that you name the user SAPJSF_<SAPSID_Java_System>.
   You can use any password.

   In addition, to make sure that this user can only be used for communication connections between systems and not as a dialog user, assign it the type Communications under Logon data.

2. In transaction SU01 create a new dialog user and assign it to role SAP_J2EE_ADMIN. This is your administrator user in AS Java.

   Recommendation
   We recommend that you name the user J2EE_ADM_<SAPSID_Java_System>. You can use any password.

   Caution
   Log on to the SAP system once with this user to change its initial password. Because the installer of AS Java verifies this password, the installation fails if this password is initial.

3. In transaction SU01 create a new dialog user and assign it to role SAP_J2EE_GUEST. This is your guest user in AS Java.
4. In transaction SU01 create the following dialog users:

- **Users for Adobe Document Services (ADS) (optional):**
  - **ADSUSER:**
    In transaction PFCG, assign the role **ADSCallers** to this user.
  - **ADS_AGENT:**
    In transaction PFCG, assign the role **SAP_BC_FP_ICF** to this user.

- **SLD Data supplier user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD data supplier user name that you enter later on during the Java system installation must be identical to this user.

  - **SLDDUSER**

- **SLD ABAP API user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD ABAP API user name that you enter later on during the Java system installation must be identical to this user.

  - **SLDAPUSER**

**Note**
Activities for the Java System

Perform the following steps in the Java system:

1. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.
2. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding SAPinst dialogs.

3.4 Checking the Windows File System

You need to check that you are using the Windows file system NTFS on hosts where you want to install the SAP system and database. NTFS supports full Windows security and long file names.

> **Note**
> You must use NTFS for an SAP system installation. Do **not** install the SAP directories on a FAT partition.

Procedure

1. Open the Windows Explorer.
2. Select the root directory.
   The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.5 Checking the Windows Domain Structure

> **Note**
> You do **not** need this step for a local installation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  In this model, the SAP system and the user accounts are included in a single domain.
Prerequisites

- You are performing a domain installation.
- You are familiar with checking Windows domain structures. For more information, see the Windows documentation.

⚠️ Caution
You cannot create local users and groups on the host that is used as domain controller. Therefore, we do not support running an SAP instance (including the database instance) on the host where the domain controller is installed.

Procedure

For a domain installation, we recommend that you check that all SAP system and database hosts are members of a single Windows domain. We recommend this for all SAP system setups.

3.6 Reducing the Size of the File Cache

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the file cache as described below.

Procedure

1. Choose Start → Control Panel → Network Connections → Local Area Connections.
2. In the Local Area Connection Status dialog box, choose Properties.
3. In the Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft Networks.
4. Select Maximize data throughput for network applications.

⚠️ Caution
If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose OK.

3.7 Required User Authorization for the Installation

Although SAPInst automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the
account the necessary authorization before you start the installation. If you attempt the installation with an account that has not the required authorization, the installation aborts. This section informs you about the authorization required for a domain and a local installation.

⚠️ Caution
Do not use the user `<sapsid>adm` for the installation of the SAP system.

**Domain Installation**

For a domain installation the account used for the installation needs to be a member of the local Administrators and the domain Admins group of the domain involved. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠️ Caution
- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and `SAPService<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. Therefore, SAP does not support a local installation for a distributed system and recommends you to install a distributed system as a domain installation.

  If you still want to perform a local installation for a distributed system, make sure that:
  - You use the same password for the `<sapsid>adm` or the `SAPService<SAPSID>` user on all hosts.
    
    The password for the `<sapsid>adm` and `SAPService<SAPSID>` user can differ.
  - You use the same master password on all hosts.
  - All hosts belong to the same Windows work group.

[Only valid for: HA (MCS)]

- In an MSCS configuration, you always have to perform a domain installation.

[End of: HA (MCS)]

- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.
- If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. However, the domain administrator has to prepare the system appropriately for you.

For more information, see Performing a Domain Installation without being a Domain Administrator [page 51].

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

**Local Installation**

For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system. If the SAP system is to run on a **single** machine, you can perform a local installation.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

### 3.8 Performing a Domain Installation Without Being a Domain Administrator

If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you, as described in this section.

**Note**

You normally perform a domain installation of the SAP system with an user who is a member of the domain Admins group, as described in *Required User Authorization for the Installation* [page 49]. The domain administrator has to:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapid>adm and SAPService<SAPSID>.
3. Add the users <sapid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

**Prerequisites**

You must perform this procedure as a domain administrator.

**Creating the New Global Group SAP_<SAPSID>_GlobalAdmin**

1. Log on as domain administrator.
2. To start the Active Directory Users and Computers Console, choose:
   - Start ➤ All Programs ➤ Administrative Tools ➤ Active Directory Users and Computers ➤
Preparation

3.8 Performing a Domain Installation Without Being a Domain Administrator

Note
If you cannot find Active Directory Users and Computers, start it as follows:
a) Choose Start Run and enter mmc.
b) Choose Console Add/Remove Snap-in... Add.
c) Select Active Directory Users and Computers.
d) Choose Add.
e) Choose Close OK.


4. Enter the following:
   Group name: SAP_<SAPSID>_GlobalAdmin

Note
Enter the SAP_<SAPSID>_GlobalAdmin group exactly as specified in the correct uppercase and lowercase.

5. Select the following:
   a) Group scope: Global
   b) Group type: Security

6. Choose OK.

Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

1. In Active Directory Users and Computers Console, right-click Users in Tree and choose:
   New User

2. Enter the following:

   Note
Enter the <sapsid>adm and SAPService<SAPSID> user exactly as specified in the correct uppercase and lowercase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for &lt;sapsid&gt;adm</th>
<th>Input for SAPService&lt;SAPSID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Full name</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>User logon name</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
</tbody>
</table>

3. Choose Next and enter the following:
   Password: <password>
3.9 Preparing the SAP System Transport Host

Confirm password: <password>

4. Select Password never expires

Note
Make sure that no other options are selected.

5. Choose Next Finish.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
2. Choose Member Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

Note
By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
2. Choose Member Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group.
4. Choose Add to add it to the list, and then OK.
5. Choose OK to close SAPService<SAPSID> Properties.

3.9 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata.
When you install an SAP system, SAPInst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.
3.9 Preparing the SAP System Transport Host

Only valid for: HA (MCS)

Note

In an MCS configuration, SAPInst by default creates the transport directory on the (ABAP) central services instance host in \usr\sap\trans.

End of: HA (MCS)

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory or an already existing transport directory, you need to prepare the transport host you are going to use:

- If the directory structure already exists, you must set up its security to allow the new system to write to it.
- If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

Procedure

1. If the transport directory does not yet exist, do the following:
   a) Create the directory \usr\sap\trans on the host to be used as the transport host.
   b) Share the \usr\sap directory on the transport host as SAPMNT and put the security settings for Everyone to Full Control for this share.
      This enables SAPInst to address the transport directory in the standard way as \\SAPTRANSHOST\SAPMNT\trans.

2. Grant Everyone the permission Full Control for the transport directory.

Caution

Remove the Full Control to Everyone permission after you have finished the installation with SAPInst and only grant Full Control on this directory to the SAP_<SAPSID>_GlobalAdmin groups of all the systems that are part of your transport infrastructure. SAPInst assigns the appropriate rights with the help of an additional SAP_LocalAdmin group. For more information, see Automatic Creation of Accounts and Groups [page 108].

Note

If, during the installation with SAPInst, you select the check box SAP System will be under NWDI control on the SAPInst screen SAP System NWDI Landscape, SAPInst copies all SCAs belonging to the usage types or software units that you installed to the global transport directory. For more information, see:

3.10 Generating the SAP Solution Manager Key

The SAP Solution Manager is the strategic application management platform for customers and for collaboration between customers and SAP. You need a SAP Solution Manager to upgrade or install all SAP software.

During the installation of the primary application server instance, you are prompted to enter the SAP Solution Manager Key.

You can generate all needed keys for your entire system landscape — development, quality assurance, and production systems — in one SAP Solution Manager system. Even if you plan to install several solution landscapes (for example in different countries), one SAP Solution Manager is still sufficient. For more information about SAP Solution Manager, see http://service.sap.com/solutionmanager.

**Prerequisites**

- You require at least SAP Solution Manager 4.0 Support Package Stack (SPS) 9.
- If required, you can install SAP Solution Manager:
  - You order SAP Solution Manager as described in SAP Note 628901.
  - You install SAP Solution Manager as described in the documentation Installation Guide — SAP Solution Manager 4.0 on <OS> : <Database> on SAP Service Marketplace at:
    - [http://service.sap.com/instguides](http://service.sap.com/instguides)  SAP Components  SAP Solution Manager  Release 4.0

**Procedure**

1. In your SAP Solution Manager system, call transaction SMSY (System Landscape Maintenance).
2. To create your SAP system in the system landscape, proceed as follows:
   a) Select the landscape component *Systems* and choose *Create New System* from the context menu.
   b) Enter the system ID in the dialog box as the system.
   c) Select the relevant product and the corresponding product version from the input help and choose *Save*.
   d) Fill in the system data as much as possible.
      For more information, see the online help at Help Application Help.
   e) Save your entries.
3. To generate the key, choose *Other object...* from the menu *System Landscape*.
4. Set the indicator *System* and choose the system that you want to install from the input help.
   If you created the system in the SAP Solution Manager in the previous step, choose this system.
5. Choose *Generate Installation / Upgrade Key*.
6. Enter the requested information.
7. Choose *Generate Key*.

**Result**

The system displays the key. Enter this key during the input phase of the installation.
More Information
For more information, see also SAP Notes [805390] and [811923].

3.11 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You obtain the installation DVDs as part of the installation package, which is the normal case.
- You download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

The tables below list the installation DVDs that are required for each instance of your SAP system. Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

Recommendation
We recommend that you make all required DVDs available in parallel.

Caution
If you perform a local installation and you have only one DVD drive on your installation host, you must copy at least the Installation Master DVD locally on your computer.

Caution
- If you copy the installation DVDs to disk, make sure that the paths to the location of the copied DVDs do not contain any blanks.
- If you use network drives for mounting the Export DVDs, make sure that the <sapsid>adm user has access to the UNC paths of the network drives. If the user does not yet exist, you have to create it manually [page 51] before you install the database instance.

1. Identify the required DVDs for your installation as listed below and keep them separate from the remaining DVDs. This helps you to avoid mixing up DVDs during the installation.

Caution
The media names listed in the tables below are abbreviated.

Note
You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.
The following table shows the required DVDs for the installation of a productive system of SAP NetWeaver Composition Environment:

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
</table>
| Central services instance, primary application server instance, additional application server instance | - Installation Master DVD  
- NetWeaver Java DVD  
- RDBMS Client DVD  
- RDBMS DVD  
- Kernel DVD |
| Database instance          | - Installation Master DVD  
- NetWeaver Java DVD  
- Kernel DVD  
- RDBMS DVD |

Host Agent (Standalone)

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
</table>
| Host Agent                | - Installation Master DVD  
- Kernel DVD |

2. Use one of the following methods to make DVDs available in parallel:
   - Before the installation:
     - Have sufficient DVD drives
     - Copy DVDs manually to local hard disks
   - During the installation:
     - Use the SAPinsist Media Browser dialog. You can check the entered location and then copy the entire DVD to the path you entered in the Copy Package to column.

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:


**Note**

If you download installation DVDs, note that DVDs might be split into several files. In this case, you have to reassemble the required files after the download.
Caution

To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at [http://service.sap.com/swdc](http://service.sap.com/swdc). You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host on which you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
   - Material number
     - All download objects that are part of an installation DVD have the same material number and an individual sequence number:
       `<material_number>_ `<sequence_number>`
       
       **Example**
       
       51031387_1
       51031387_2
       ...
   
   - Title
     - All objects that are part of an installation DVD have the same title, such as
       `<solution><DVD_name><OS>` or `<database>RDBMS<OS>` for RDBMS DVDs.
3. Download the objects to the download directory.
4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number— for example 51031387_1, then 51031387_2, and so on.
   During the download SAPCAR sets up the structure of the installation DVD.

Note

SAPCAR asks if you want to replace existing files, for example `LABELIDX.ASC`. Always accept with **Yes**.
4 Installation

This section includes the installation steps that you have to perform for the:

- Standard system
- Distributed system
  
  Only valid for: HA (MSCS)

- High-availability system
  
  End of: HA (MSCS)

- Additional application server instance
- Host agent

**Standard System**

1. You install the MS SQL Server database software [page 61] on the host where you install the SAP system.
2. You install the SAP system with SApInst [page 66].

   ![Note]

   In a standard system all mandatory instances are installed on one host in one installation run.

3. You can now continue with Post-Installation [page 77].

**Distributed System**

1. On the host where the primary application server instance is to run, you install the MS SQL Server Native Access Client (SNAC) software [page 61].
2. On the host where the primary application server instance is to run, you run SApInst [page 66] to install the central services instance.
3. On the database instance host, you install the MS SQL Server database software [page 61].
5. On the primary application server instance host, you run SApInst [page 66] to install the primary application server instance.

   ![Note]

   Make sure that you have already installed the MS SQL Server Native Access Client (SNAC) software [page 61] on this host.
6. If required, on the additional application server instance host(s), you install the additional application server instance(s) (see below).

7. You can now continue with Post-Installation [page 77].

---

**High-Availability System**

If you want to perform a Microsoft Cluster Service (MSCS) installation, see Installation [page 141] in chapter High Availability with Microsoft Cluster Service.

1. You perform the MSCS-specific installation steps [page 141].
2. You can now continue with Post-Installation [page 77].

---

**Additional Application Server Instance(s)**

You perform the following steps on each host where you install the additional application server instance(s).

1. You install the MS SQL Server Native Access Client (SNAC) software [page 61].

   - **Note**
     This step is not required if you install the additional application server instance on the same host as the standard system.

2. You run SAPInst [page 66] to install the additional application server instance(s).

   - **Caution**
     In a high-availability system, you must install at least one additional application server instance.

3. You can now continue with Post-Installation [page 77].

---

**Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)**

- You install additional components [page 74] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site
- You install SAP Memory Analyzer [page 75] for SAP NetWeaver Composition Environment.
4.1 Installing the SQL Server Database Software

The following sections describe how to install the SQL Server 2005 database software. The SQL Server software has to be installed on each host in the system where you intend to set up an SAP instance. Depending on the type of host involved, you either have to install the software for the database client or server.

To install the SQL Server database software in a standard system you have the following options:

- You install the SQL Server database software automatically with SQL4SAP [page 61].
- You install the SQL Server database server software manually [page 62].
- You install the SQL Server 2005 Native Access Client (SNAC) software manually [page 65].

4.1.1 Installing the SQL Server Database Software with SQL4SAP

This section describes how to install the SQL Server 2005 database software automatically.

Note

For more information about installing with SQL4SAP .VBS, see Customized Installation of SQL Server for an SAP System with SQL4SAP .VBS (SQL4SAP_docu.pdf) and the readme .txt, both of which are located in the root directory of the SQL Server RDBMS DVD.

Only valid for: HA (MSCS)

Caution

The SQL4SAP .VBS script does not support Microsoft Cluster Service (MSCS). If you want to run the script in an MSCS configuration, you get an error message. For more information about installing the SQL Server database software for MSCS, see Clustering the SQL Server Database Server Software [page 142].

End of: HA (MSCS)
You use the SQL4SAP .VBS script to automatically install:

- One of the following SQL Server 2005 editions:
  - 64-bit SQL Server 2005 Enterprise Edition on x64 systems
  - 64-bit SQL Server 2005 Enterprise Edition on IA64 systems
- Default Instances, Named Instances, or SQL Server Client Tools Only.
- The latest SQL Server 2005 service pack

![Note]
For up-to-date information about installing SQL Server 2005 with SQL4SAP, read SAP Note 896566.

**Procedure**

1. Insert the SQL Server 2005 RDBMS DVD in your DVD drive or mount the network share locally.
2. Double-click SQL4SAP .VBS located in the root directory.
3. Follow the instructions and enter the required information in the installation screens.

**4.1.2 Installing the SQL Server 2005 Database Server Software Manually**

This section describes how to install the SQL Server 2005 database server software manually.
The SQL Server 2005 database server software must be installed on the database host.

![Only valid for: HA (MSCS)]

![Note]
If you use an MSCS environment, you have to use the manual procedure. For a non-MSCS SAP system, you can also use the SQL4SAP script [page 61] to install SQL Server 2005.

![End of: HA (MSCS)]

**Prerequisites**

When installing SQL Server 2005, make sure that you have enough free disk space available on the system drive for the:

- .Net Framework
  - For 64-bit also the 64-bit .Net Framework in addition to the 32-bit .Net Framework is installed.
- SQL Server Client Tools
- SQL Server instance
- Temporary space during the installation
The required disk space depends on the type of SQL Server components already installed or to be installed. It also depends on the system. For a 64-bit system you might require 2 GB of free disk space.

Procedure

1. Log on to the host as a local administrator.
2. Insert the SQL Server 2005 RDBMS DVD in your DVD drive or mount it locally.
4. Start the installation program with setup.exe.
5. Enter the required information as specified in the table below.

Note

The installation writes the log files to the directory %ProgramFiles%\Microsoft SQL server\90\Setup Bootstrap\LOG. You find the summary of the setup log in summary.txt in the same directory.

<table>
<thead>
<tr>
<th>Window</th>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>End User License Agreement</td>
<td>Accept the licensing terms and conditions and choose Next.</td>
</tr>
<tr>
<td>Installing Prerequisites</td>
<td>Choose Install and, if required, Next.</td>
</tr>
<tr>
<td>Welcome to the Microsoft SQL Server Installation Wizard</td>
<td>Choose Next.</td>
</tr>
<tr>
<td>System Configuration Check</td>
<td>a) Check your system configuration and, if required, set up the required configuration.</td>
</tr>
</tbody>
</table>

Note

- For more information about the required system configuration for a software component, choose Messages.
- IIS is not required for an SAP system. Therefore, you can ignore the warning about the IIS Feature Requirement.
- If there is a warning in COM Plus Catalog Requirement, correct the configuration before you proceed with the installation.

b) Choose Next.

Components to Install

a) Select:
- SQL Server Database Services
- Workstation components, Books Online and development tools.

b) Choose Advanced
### Installation

#### 4.1 Installing the SQL Server Database Software

<table>
<thead>
<tr>
<th>Window</th>
<th>Server Input</th>
</tr>
</thead>
</table>
| **Feature Selection** | a) Expand *Database Services* and deselect *Replication*.  
                          b) Expand *Client Components* and if available, deselect  
                          *Business Intelligence Development Studio*.  
                          Note: We recommend that you deselect these features  
                          as they are not required for an SAP system.  
                          c) Choose Next. |
| **Instance Name**   | Select the instance you want to install and choose Next.  
                          Note: SAP recommends to install a *Default* instance. |
| **Service Account** | a) Select one of the following options:  
                          - Use the built-in System account for each service and  
                            choose Local System or Network Service.  
                          - Use a domain user account, and enter the user  
                            name and password.  
                          b) Under *Start services at the end of setup* make sure that  
                            *SQL Server* and *SQL Server Agent* are selected.  
                          Note: If you use a named instance, you must also  
                            select SQL Browser.  
                          c) Choose Next. |
| **Authentication Mode** | a) Select *Mixed Mode* (*Windows Authentication and SQL Server Authentication*).  
                          This mode is required for a Java or ABAP+Java  
                          system.  
                          If you choose this mode, you have to set the  
                          password for the *sa* login.  
                          Note: SAPinst automatically changes the  
                          authentication mode into *Mixed Mode*  
                          when installing a Java system.  
                          The password for the *sa* login must comply  
                          with the Windows password policy.  
                          b) Choose Next. |
6. When you have finished the installation, enable the Named Pipes and TCP/IP protocol in the SQL Server Configuration Manager as follows:
   a) Choose Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL Server Configuration Manager.
   b) Expand SQL Server 2005 Network Configuration and select one of the following:
   c) For a default instance, select Protocols for MSSQLServer.
   d) For a named instance, select Protocols for <SAPSID>.
   e) In the right-hand pane, under Protocol Name, right-click Named Pipes and TCP/IP, and select Enable.
7. Restart SQL Server.
8. Install the latest SQL Server service pack and hotfix, if available. For more information, see SAP Note 62988.

### 4.1.3 Installing the SQL Server 2005 Native Client Software Manually

This chapter describes how to install the SQL Server 2005 Native Access Client (SNAC) software. The SQL Server 2005 client software must be installed on all hosts without the database. It enables the communication between a host and the database.

**Procedure**

1. Log on as local administrator to the host where you want to install an application server.
2. Insert the SQL Server 2005 RDBMS DVD in your DVD drive or mount it locally.
3. Change to the platform-specific folder and choose sq1nc11.msi

Note
You also find the sq1nc11.msi file on the Microsoft SQL Server CD in the Setup directory. In this case, make sure that you get the current version that fits to the installed SQL Server service pack.

4. Follow the instructions in the SQL Server installation setup screens.
5. Install the latest SQL Server service pack and hot fix, if available. For more information, see SAP Note 62988.

4.2 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

This section describes an installation where SAPinst, SAPinst GUI, and the GUI server are running on the same host. If required, you can instead perform a remote installation with SAPinst [page 101], where SAPinst GUI is running on a separate host from SAPinst and the GUI server.

When you start SAPinst, SAPinst GUI and the GUI server also start. SAPinst GUI connects via a secure SSL connection to the GUI server and the GUI server connects to SAPinst.

Note the following information about SAPinst:

- SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.

- SAPinst creates a subdirectory for each installation option called <sapinst_instdir>\<installation_option_directory>, which is located in %ProgramFiles%\.

- The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPinst has stopped running. Directories called sapinst_exe.xxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them.

The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.
Caution

If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPinst, GUI server, SAPinst GUI, and HTTP server. SAPinst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.

In this case, open a command prompt and change to the required directory as follows:

<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>.

Enter the following command in a single line:

```bash
sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
GUISERVER_HTTP_PORT=<free_port_number_http_server>
```

To get a list of all available SAPinst properties, go to the directory (%TEMP%\sapinst_exe.xxxxx.xxxx), after you have started SAPinst, and enter the following command:

```bash
sapinst.exe -p
```

If you want to terminate SAPinst and the SAPinst Self-Extractor, choose one of the following options:

- Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
- Click the icon for the SAPinst output window located in the Windows tray and choose File > Exit.

Using SAPinst GUI

The following table shows the most important functions that are available in SAPinst GUI:

<table>
<thead>
<tr>
<th>SAPinst GUI Functions</th>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function key</td>
<td>F1</td>
<td>Dispalys detailed information about each input parameter</td>
</tr>
<tr>
<td></td>
<td>Menu option</td>
<td>File &gt; Exit</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
</tbody>
</table>

Note

If you need to log off during the installation from the host where you control the installation with SAPinst GUI, the installation continues while you are logged off. You can later reconnect to the same SAPinst installation from the same or another host. For more information, see Starting SAPinst GUI.
### Prerequisites

- You use an account with the required user authorization to install the SAP system with the SAPinst tool [page 49].
- You need at least 130 MB of free space in the installation directory for each Java installation option. In addition, you need 60-200 MB free space for the SAPinst executables.
- Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 28] before you start the installation.
- Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 36].
- If you are installing a second or subsequent SAP system in an existing database, make sure that the database is up and running before starting the installation.
For more information, see Installation of Multiple Components in One Database [page 24].

**Procedure**

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPins from the SAP Installation Master DVD by double-clicking sapinst.exe from the following path:
   
   `<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>`

   SAPins GUI starts automatically by displaying the Welcome screen.
   However, if there is only one component to install, SAPins directly displays the first input dialog without presenting the Welcome screen.
3. In the Welcome screen, choose the required SAPins installation option [page 70] from the tree structure.

   ![Note]
   If you want to use the following installation options listed under Software Life-Cycle Options, you must start them **before** you start the installation of the SAP system:
   
   - **Operating System Users and Groups**
     Choose this option, if the operating system users do not yet exist and you do not want to create them manually.

   ![Note]
   Make sure that you have the **required user authorization** [page 49] for these accounts before you start the installation.

4. If SAPins prompts you to log off from your system, log off and log on again.

   SAPins restarts automatically.

5. Follow the instructions in the SAPins dialogs and enter the required parameters.

   ![Note]
   For more information about the input parameters, position the cursor on the required parameter and press **F1**.

6. To start the installation choose **Start**.

   SAPins starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPins shows the dialog **Execution of <Option_Name> has been completed successfully**.

7. If you want to install an additional application server instance for a standard (central) or distributed system, choose the installation option ![ ]<SAP System> ![Software Life-Cycle Options> ![Additional Application Server Instances> ![Additional application server instance](

8. We recommend deleting all files in the directory `%userprofile%\sdtgui\`. 

---

11/05/2007   PUBLIC   69/164
4.3 SAPinst Installation Options

This section provides information about the following installation options in SAPinst:

- Installation Options
- Software Life-Cycle Options

**Note**

- Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.
- If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing "<SAP System> > Software Life-Cycle Options > Additional Application Server Instance > Additional Application Server Instance".
- If required, install additional CE components by choosing "<SAP System> > Software Life-Cycle Options > Additional CE Components > Additional CE components".
- If required, install SAP Memory Analyzer by choosing "<SAP System> > Software Life-Cycle Options > SAP Memory Analyzer > SAP Memory Analyzer".

**Installation Options**

You choose SAP Systems with <your database> to install a SAP system with usage types or software units. You can install the following system variants:

- **Standard System**

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| Standard System     | Installs a complete SAP system including the following instances on one host:  
|                     | Central services instance (SCS)  
|                     | Database instance  
|                     | Primary application server instance  
|                     | You can install a standard system in the following parameter modes: |
### Installation Options for a Distributed System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS) and prepares the SAP global host. Mandatory step in installing a distributed SAP system with usage types or software units based on AS Java.</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance. Mandatory step in installing a distributed SAP system. You must have finished the Central Services Instance (SCS) installation, before you can choose this installation option.</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional software units. Mandatory step in installing a distributed SAP system on several hosts. You must have finished the database instance installation.</td>
</tr>
</tbody>
</table>

**Note**

You require at least usage type AS Java or AS ABAP. You can choose the usage types or software units on the next screen.

#### Distributed System

#### High-Availability System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS)</td>
</tr>
</tbody>
</table>
### Installation Options

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>First MSCS Node</td>
<td>Performs the following steps on the first Microsoft Cluster Service (MSCS) node:</td>
</tr>
<tr>
<td></td>
<td>- Creates the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS and SCS instances to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the SCS instance to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS instance to the SAP cluster group</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance</td>
</tr>
<tr>
<td>Host Agent</td>
<td>Installs the host agent</td>
</tr>
<tr>
<td></td>
<td><strong>Only valid for: HA (MSCS)</strong></td>
</tr>
<tr>
<td></td>
<td>You must perform this step on the first and on the additional MSCS node.</td>
</tr>
<tr>
<td></td>
<td><strong>End of: HA (MSCS)</strong></td>
</tr>
<tr>
<td>Additional MSCS Node</td>
<td>Configures an additional Microsoft Cluster Service (MSCS) node to run the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>You must have completed the configuration of the first MSCS node and the database instance installation.</td>
</tr>
<tr>
<td>Enqueue Replication Server Instance</td>
<td>Installs an enqueue replication server, which contains a replica of the lock table (replication server)</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional usage types or software units</td>
</tr>
<tr>
<td>Additional Application Server Instance</td>
<td>Installs an additional application server instance</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>You require at least one additional application server instance in a high-availability system configured with MSCS.</td>
</tr>
<tr>
<td></td>
<td><strong>End of: HA (MSCS):HA (UNIX):HA (z/OS)</strong></td>
</tr>
</tbody>
</table>

---

### Software Life-Cycle Options

You use the options located in this folder to perform the following tasks or to install the following components:

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Preparations</td>
<td><strong>Host Agent</strong></td>
</tr>
<tr>
<td></td>
<td>Choose [Additional Preparations] [Host Agent] [Host Agent] to install the host agent with the profiles SAPSystem=99 and SAPSystemName=SAP.</td>
</tr>
<tr>
<td></td>
<td>The host agent contains all of the required elements for centrally monitoring any host.</td>
</tr>
<tr>
<td></td>
<td>Normally you do not need to install the host agent separately, because it is automatically installed during the installation of all SAP NetWeaver components, except TREX.</td>
</tr>
<tr>
<td></td>
<td>You only need to install the host agent separately in the following cases:</td>
</tr>
<tr>
<td></td>
<td>- You want to centrally monitor a host that does not have an SAP component.</td>
</tr>
</tbody>
</table>
## SAPinst Installation Options

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You want to perform an upgrade to SAP NetWeaver. For more information, see Host Agent as a Separate Installation [page 17].</td>
</tr>
<tr>
<td></td>
<td>Operating system users and groups Creates all operating system users for your SAP system if they do not yet exist.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong> Perform this SAPinst option before you start the installation.</td>
</tr>
<tr>
<td></td>
<td>Make sure that you have the required user authorization [page 49] for these accounts before you start the installation.</td>
</tr>
<tr>
<td></td>
<td>Prerequisites check Choose Additional Preparations Prerequisites Check if you want to check your hardware and software requirements before you start the installation. Otherwise, SAPinst automatically checks the hardware and software requirements during the installation with the Prerequisite Checker. If any changes are necessary to the SAP system or operating system settings, SAPinst automatically prompts you. For more information, see Running the Prerequisites Checker in Standalone Mode [page 36].</td>
</tr>
<tr>
<td>Additional Application Server Instances</td>
<td>Choose Additional Application Server Instances Additional Application Server Instance to install one or more additional application server instance(s) in an already installed SAP system, if required.</td>
</tr>
<tr>
<td>Additional CE Components</td>
<td>Choose this option to install additional CE components, such as Composition Tools, Adobe Document Services, Composite Voice, IDE Update Site.</td>
</tr>
<tr>
<td>SAP Memory Analyzer</td>
<td>Choose this option to install SAP Memory Analyzer. SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive.</td>
</tr>
<tr>
<td>System Copy</td>
<td>Choose this option to perform a system copy. For more information, see the system copy guide for your SAP system on SAP Service Marketplace at: <a href="http://service.sap.com/instguides">http://service.sap.com/instguides</a> &lt;SAP system&gt; Installation.</td>
</tr>
<tr>
<td>Uninstall</td>
<td>Choose this option to uninstall your SAP system, standalone engines, or optional standalone units. For more information, see Deleting an SAP System [page 111].</td>
</tr>
</tbody>
</table>

11/05/2007
4.4 Installing Additional Components (Optional)

You can install the following additional components:

- Composition Tools
- Adobe Document Services
- Composite Voice
- IDE Update Site

Prerequisites

You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.

Note

- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, <01adm>). During the installation SAPinst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 66].
3. In the Welcome screen, choose ▶ SAP NetWeaver CE Productive System ▶ Software Life-Cycle Options ▶ Additional CE Components ▶ Install Additional Components ▶.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.

After the installation, you can access the offline documentation by choosing ▶ Start ▶ All Programs ▶ SAP NetWeaver Composition Environment ▶ <SAPSID> ▶.
5. Follow the screens and enter the required parameters.

**Note**
For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog Execution of <Service_Name> has been completed successfully.

**Note**
After installing additional components, you need to perform CE-specific post-installation activities [page 86] to get the system up & running.

### 4.5 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with an extremely fast and powerful feature set.

The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps.

You can install SAP Memory Analyzer as an additional tool.

**Procedure**

**Note**
When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, c01adm). During the installation SAPinst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 66].
3. In the Welcome screen, choose \textit{SAP NetWeaver CE Productive System} \foreignlanguage{de}{\textit{Software Life-Cycle Options} \textit{SAP Memory Analyzer} \textit{Install SAP Memory Analyzer}}.

4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

   \textbf{Note}
   If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
   After the installation, you can access the offline documentation by choosing \textit{Start} \textit{All Programs} \textit{SAP NetWeaver Composition Environment} \textit{<SAPSID>}.

5. Follow the screens and enter the required parameters.

   \textbf{Note}
   For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press \texttt{F1}.

   After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog \textit{Execution of <Service_Name> has been completed successfully}. 
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:
- Standard, distributed or high-availability system
- Additional application server instance
- Host agent as a separate installation

Post-Installation Steps for a Standard, Distributed, or High-Availability System

Note
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. If required, you perform a full system backup [page 89] immediately after the installation has finished.
2. You check whether you can log on to the SAP system [page 78].

Note
In a distributed or high-availability system you check whether your can log on to every instance of the SAP system that you installed.

3. You ensure user security [page 81].
4. You install the SAP license [page 79].
5. You configure the remote connection to SAP support [page 80].
6. On the primary application server instance host, you apply the latest kernel and Support Packages [page 80].
7. You check the Java manuals [page 85] for information that is relevant for running your Java system.
8. You perform CE-specific post-installation steps [page 86].
9. You perform a full system backup [page 89].

Post-Installation Steps for an Additional Application Server Instance

1. You check whether you can log on to the additional application server instance [page 78].
2. You perform a full system backup [page 89].

Post-Installation Steps for the Host Agent as a Separate Installation
You perform the post-installation steps for the Host Agent [page 84].
5.1 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommendation: We recommend that you call the user J2EE_ADM_&lt;SAPSID_Java_System&gt;. The maximum length is 12 characters.</td>
</tr>
</tbody>
</table>

Prerequisites

- The SAP system is up and running.

Logging On to the Java Application Server

You access AS Java with a URL using a Web browser from your client machines. To log on to the Java application server, proceed as follows:

1. Start a Web browser and enter the following URL:
   
   ```
   http://<hostname_of_Java EE_Engine_Server>:5<Instance_Number>00
   ```

   **Note**
   
   You must always enter a two-digit number for `<Instance_Number>`. For example, do not enter 1 but instead enter 01.

   **Example**
   
   If you installed the SAP NetWeaver Application Server Java on host saphost06 and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:
   
   ```
   http://saphost06:50400
   ```

   The start page of the SAP NetWeaver Application Server Java appears in the Web browser.

2. Log on by pressing the icon of any of the provided applications, for example the *SAP NetWeaver Administrator*. 
5.2 Installing the SAP License

You must install a permanent SAP license. When you install your SAP system, a temporary license
is automatically installed. This temporary license allows you to use the system for only four weeks
from the date of installation.

⚠️ Caution

Before the temporary license expires, you must apply for a permanent license key from SAP.
We recommend that you apply for a permanent license key as soon as possible after installing your
system.

Procedure

For information about the installation procedure for the SAP license, see:

Operations Manual for SAP NetWeaver (TOM) ➜ General Administration Tasks ➜ License Administration ➜

Only valid for: HA (MSCS)

💡 Note

The license key is bound to the hardware key of the host where the message server is running.
In a high-availability system with MSCS, the message server is part of the (A)SCS instance that can
run on different MSCS node. Therefore you must install the SAP license on both nodes.
You have to do failover from the first MSCS node where the (A)SCS instance is installed to the
second MSCS node. Use the hardware key of the second MSCS node for the installation of the
second SAP license.

End of: HA (MSCS)

More Information

For more information about SAP license keys and how to obtain them, see SAP Service Marketplace at

5.3 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

Procedure

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
5.4 Configuring the Remote Connection to SAP Support

3. In a high-availability system with MSCS, you must configure all systems in the TMS landscape. To do this implement SAP Note 943334.

More Information

5.4 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at [http://service.sap.com/remoteconnection](http://service.sap.com/remoteconnection).

5.5 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

Caution
Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these on SAP Service Marketplace at [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes). The release notes might include information about steps you have to perform after you have applied the support packages.

Procedure
5.6 Ensuring User Security

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location – such as a DVD – and then delete the installation directory.

Recommendation

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see the SAP Library at:


Caution

Make sure that you perform this procedure before the newly installed SAP system goes into production.

Prerequisites

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

Procedure

For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at [http://service.sap.com/securityguide](http://service.sap.com/securityguide):
Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You do not need to change the password of this user after the installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

**Note**

You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system – see the first table below
- With the users stored in the database – see the second table below

The next two tables show these ways of managing the users.

### SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user's password is stored in secure storage. Therefore, whenever you change the administrator's password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 85].</td>
</tr>
<tr>
<td></td>
<td>Recommendation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>We recommend that you call the user</td>
<td></td>
</tr>
<tr>
<td></td>
<td>J2EE_ADMIN_&lt;SAPSID_Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
<tr>
<td>Guest</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td></td>
<td>Recommendation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>We recommend that you call the user</td>
<td></td>
</tr>
<tr>
<td></td>
<td>J2EE_GST_&lt;SAPSID_Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
<tr>
<td>Communication user for Application Server Java</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Specify this user as a Communications user and not as a dialog user. This user exists at least in the SAP system client that you specified during the installation.</td>
</tr>
<tr>
<td></td>
<td>Recommendation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>We recommend that you call the user</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAPJSF_&lt;SAPSID_Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
</tbody>
</table>
### 5.6 Ensuring User Security

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users for Adobe Document Services (ADS)</td>
<td>ADSUSER</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system. You must have created this user manually in the external ABAP system before you started the installation. For more information, see Preparing User Management for an External ABAP System [page 45].</td>
</tr>
<tr>
<td>Data supplier user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually [page 45]. The recommended name is SLDDSUSER.</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system</td>
</tr>
<tr>
<td>ABAP API user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually [page 45]. The recommended name is SLDDAPIUSER.</td>
<td>User exists at least in in the clients 000 and 001 of the external ABAP system</td>
</tr>
</tbody>
</table>

**SAP System Users Stored in the Database**

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The name that you gave this user during the installation or the default name Administrator</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool. For more information, see Checking the SAP Java Documentation [page 85].</td>
</tr>
<tr>
<td>Guest</td>
<td>The name that you gave this user during the installation or the default name Guest</td>
<td>Lock this user for interactive logon.</td>
</tr>
</tbody>
</table>
5.7 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or separately on another host.

**Procedure**

1. You check whether the installed services are available as follows:
   a) Log on as user `sapadm`.
   b) Check whether the following services are available:
      - The control program `saphostexec`
      - The operating system collector `saposcol`
      - The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsrv` in host mode)

   **Note**
   When the host is booted, the services `SAPHostControl` and `SAPHostExec` automatically start the installed programs

2. You configure the host agent according to your requirements.

**More Information**
For more information, see the SAP Library at:
5.8 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server Java (AS Java) and about SAP Java technology.

**Procedure**

1. Go to the following place in the documentation:
   

2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architecture Manual</td>
<td>This manual describes the architecture of a Java or ABAP+Java system. It contains information on:</td>
</tr>
<tr>
<td></td>
<td>- Java cluster architecture including central services, <strong>load balancing</strong>, and <strong>high availability</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Application Server Java (AS Java) system architecture</td>
</tr>
<tr>
<td></td>
<td>- SAP NetWeaver <strong>Java development infrastructure</strong>, including SAP NetWeaver Developer Studio</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> \ The SAP NetWeaver Developer Studio is the SAP development infrastructure for Java. The Architecture Manual describes the integration of the SAP NetWeaver Developer Studio into the SAP development infrastructure.</td>
</tr>
<tr>
<td>Administration Manual</td>
<td>This manual describes how to administer the SAP system, focusing on AS Java. It contains information on:</td>
</tr>
<tr>
<td></td>
<td>- System landscape administration</td>
</tr>
<tr>
<td></td>
<td>- Software life-cycle management</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> \ This part of the manual contains important information about:</td>
</tr>
<tr>
<td></td>
<td>- Installation information</td>
</tr>
<tr>
<td></td>
<td>- System Landscape Directory (SLD)</td>
</tr>
<tr>
<td></td>
<td>- Software Lifecycle Manager (SLM)</td>
</tr>
<tr>
<td></td>
<td>- Java Support Package Manager</td>
</tr>
<tr>
<td></td>
<td>- Administration of SAP NetWeaver Java Development Infrastructure (JDI)</td>
</tr>
<tr>
<td></td>
<td>- AS Java and AS Java security</td>
</tr>
</tbody>
</table>
5.9 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.

Running the Configuration Wizard (Optional)

Note
You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPinst has finished, run the configuration wizard to apply automated configuration tasks to your system.
For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry Webservice Destinations
- Configuration and Mirroring of local NWDS Update Site
- Initial setup ADS in CE

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

More Information
For troubleshooting AS Java, see the J2EE Engine Problem Analysis Guide at:


<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Supportability and performance management</td>
</tr>
<tr>
<td></td>
<td>- Administration and configuration of Web Dynpro runtime environment</td>
</tr>
<tr>
<td></td>
<td>- Administration of the XML Data Archiving Service (XML DAS)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Java Development Manual</th>
<th>This manual describes the technologies for developing Java-based business applications. It explains how to use the SAP Netweaver Developer Studio, which is the SAP Java development environment.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Migration Manual</th>
<th>This manual contains all the information you need to migrate an application created in J2EE Engine 6.20.</th>
</tr>
</thead>
</table>
Enabling Adobe Document Services

If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.

2. From the Start menu, open Control Panel > Administrative Tools > Computer Management > Services and Applications > Services .

3. Select SAP<SID>_<Instance_Number> (for example, SAPCE1_00) and open Properties from the context menu.

4. On the Log On tab page, enable the Local System account indicator.

5. Repeat the above steps for the second SAP<SID>_<Instance_Number> service that you see in the list.

6. Start the AS Java system.

Adobe LiveCycle Designer
For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.

Enabling Services Registry
You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:

- Java Application Server and Composition Platform
- Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:

```text
CE_Complete_Stack_production_full
```

Note
For more information about what configuration templates are available, see Configuration Templates [page 95].
See also

Developing and Composing Applications ▶ Consuming Enterprise Services ▶ Searching for Services ▶ Services Registry ▶
Tasks ▶ Searching & Browsing Service Definitions ▶ Configuring the Services Registry  

Configuring the Portal in SAP NetWeaver CE
After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:
   
   
   where <host> is the host name of your server and <httpport> is the port number of your server.
3. In the Portal Mode Configuration Tool, choose Activate Development Mode to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in

Configuration of SAP NetWeaver Composition Environment ▶ Configuration for CE Additional Components ▶ Configuring the Portal  

Changing the Password for the Internet Communication Manager (ICM)
You can monitor and manage the Internet Communication Manager (ICM) from the command line program.

After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:

1. Log on at operating system level to the computer where the ICM is running.
2. Start the program icmon with icmon -a profile=<instance_profile> to maintain the authentication file (default: authfile.txt).
3. Choose a to add a user.
4. Choose c to change the password of the existing user.
5. Choose s to save your settings.

Further Configuration Steps
After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps.

Refer to the following documentation to proceed with your tasks:
If you are a system administrator, refer to [http://help.sap.com/nwce] Administrator’s Guide. It contains information about how to configure and administer your system.

If you are a developer, refer to [http://help.sap.com/nwce] Developer’s Guide. It provides guidelines for developing applications using the SAP NetWeaver CE.

Note
The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose Start All Programs SAP NetWeaver Composition Environment 1.0 Documentation.

5.10 Performing a Full System Backup

You must perform a full system backup after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

Prerequisites
- You are logged on as user <sapid>adm.
- You have shut down the SAP system and database.

Procedure
Back up your system including the operating system disk, system state, and all other disks.
This page is intentionally left blank.
6 Updating SAP NetWeaver Composition Environment

If you want to apply the latest support packages and patches to your SAP NetWeaver CE system or update your applications, use the update management service of SAP NetWeaver CE.

Before You Start the Update

- Before you start the update, apply SAP Note 1088002.
- You need to perform this once on each system.

Updating Your SAP NetWeaver CE System Manually

If you have a system that was installed with SP0 or SPI, proceed as follows:

   - Search for SERVERCORE01_0-10004571.SCA SP01 for J2EE ENGINE SERVERCORE 7.05.
   - Before deploying the SCA using telnet, change the permissions using the following command:
     ```
     chmod 777 SERVERCORE01_0-10004571.SCA
     ```
   - For more information, see SAP Note 1073329.
2. Manually deploy the three XI third-party SDAs using telnet.
   - For more information, see SAP Note 1088386.
3. Exchange the engine template.

Note

Before changing the current template, note down the name of the currently active template. You will need it at the end of the update procedure to reactivate the original template again.

- Navigate to the configtool subdirectory of your installation directory, for example
  ```
  C:\usr\sap\CE1\J01\j2ee\configtool
  ```
- Run the file configtool.bat.
- Highlight the template and choose File > Change System Template.
- Switch from the current template to the instance_development template.
- Save your settings and restart the server.
  To do this, open SAP Management Console, select the node and choose the restart option.

5. Stop the SAP Management Console.

6. From the download folder from SAP Service Marketplace, run the update tool **update<ID>.exe** to apply patches and updates to your SAP NetWeaver CE system.

7. After running the update tool wait until the engine is fully started.

8. To complete the update process, change back the system template to the original one.

---

**Caution**

If you are running a cluster system, make sure that you change back to the original template on all dialog instances.

---

8. Restart the system.

**Update Management Service**

Update Management Service is intended to help automate the process of downloading and installing the latest Support Package Stack from SAP Service Marketplace. The Update Management tool will connect to SAP Service Marketplace and look for the latest support package stack available for your system. For example, if your system is on SP3 and the latest support package available is SP5, the Update Management Service will download and apply SP5 to your system. If, however, you want to go to an intermediate support package stack, you have to download the stack manually.

**Procedure**


2. Follow the on-screen instructions and enter the required logon information.

3. The Update Management tool checks the system for installed components and support package stack level.

4. The Update Management tool checks for updates and new support package stacks on SAP Service Marketplace and applies them automatically.

When the update has successfully completed, SAPinst shows the dialog *The system is up-to-date.*
7 Additional Information

The following section provides additional information about the installation of SAP NetWeaver Composition Environment.

7.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:
1. Run the update tool as described in Updating the SAP NetWeaver CE system [page 91].

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the tool displays descriptions such as Applying Support Packages, you can ignore them.</td>
</tr>
</tbody>
</table>

2. In the dialog screens, specify the directory where your SCAs are located.
3. Follow the on-screen instructions.

7.2 Troubleshooting – Repairing an Inconsistent MaxDB Installation

Prerequisites
During the preinstallation phase, the installation tools checks the Microsoft Windows registry for already installed MaxDB software.
If the registry key is found but there is no software on the hard drive, you receive the following message:
The existing MaxDB software is not consistent. Check the file system and registry.
The most common reason for this inconsistency is the manual deletion of the software from the file system without using the specified tools.
**Procedure**

To repair this inconsistency, proceed as follows:

1. Choose **Start > Control Panel > Administrative Tools > Services**.
2. Make sure the services `SAPDBWWW`, `SAPDB:*`, and `XServer` are stopped.
3. Choose **Start > Run** and run the command `regedit`.
4. Go to `My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAP DBTech > Key IndepPrograms`.
   - The key contains a path to a folder.
   - a) Check if this folder exists on the file system.
   - b) Note down the value of `Key IndepPrograms` for later usage (see step 7).
   - If the path does not exist in the file system, delete the key `SAP DBTech`.
5. Delete the following keys:
   - `My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAP DBTech-*`
   - `My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAPDBWWW`
   - `My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\XServer`
6. Choose **Start > Control Panel > System > Advanced > Environment Variables > System Variables > Path**.
7. Delete the following paths from the variable:
   - `<IndepPrograms>/bin`
   - `<IndepPrograms>/pgm`
8. Reboot your computer.

**7.3 Restarting the MaxDB Server Manually**

If, after a reboot, the database server is not running automatically, you need to restart the MaxDB server manually.

**Production Systems**

To restart the MaxDB server manually, proceed as follows:

1. Open a command prompt and enter the following command: `net start sapdbwww`
   - OR
   - Choose **Start > All Programs > Administrative Tools > Services**. Double-click on `SAP DB WWW` and choose `Start`.
2. Open the SAP Management Console and choose **SAP Systems > <SAPSID> > <machine name>**.
3. Enter the master password and choose `Logon`.
4. Choose `Online`. When the database server is online, you can restart the engine.

**Development Systems**

To restart the MaxDB server manually, choose **Start > All Programs > SAP NetWeaver Composition Environment CE > Application Server <SAPSID> > Start Application Server**.
7.4 Restarting the MS SQL Server Manually

If, after a reboot, the database server is not running automatically, you need to restart the MS SQL Server manually.

Procedure

1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Services ➤.
2. Look for the service named SQL Server <name>, where <name> is MSSQLSERVER for the default instance or <instance name> for a named instance.
3. If the service status is not started, right-click the service and choose Start in the context menu.
4. To insure the service is started automatically after each system restart, right-click it and choose Properties. Select Automatic as the startup type.

7.5 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options. The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the <system_mode> parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java_EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>
If your selection cannot be mapped to one of the combinations in the above table, the template \texttt{CE\_Complete\_Stack\_<system\_mode\>_full} is applied. It starts all applications and services needed to run the complete stack.

You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template \texttt{CE\_Complete\_Stack\_<system\_mode\>_full} to \texttt{CE\_Java\_EE\_<system\_mode\>_full}, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.

For more information about applying configuration templates, see \url{http://help.sap.com/nwce} \textit{Administrator’s Guide} \textit{Configuration of SAP NetWeaver CE} \textit{Initial System Configuration} \textit{AS Java Configuration} \textit{Activating a Configuration Template}.

\textbf{Note}

Make sure that you do not apply a development template to a productive system or vice versa.

\section*{7.6 SAP Directories}

This section describes the SAP directories that SAPinst creates during the installation.

\textbf{Only valid for: HA (MCS)}

If you want to install an MCS system, see also: \textit{Directories in an MCS Configuration} [page 126].

\textbf{End of: HA (MCS)}

SAPinst creates the following base directories required for the SAP system:

\begin{itemize}
  \item \texttt{	extbackslash usr\textbackslash sap}

  This directory is created on the:
  \begin{itemize}
    \item **Global** host and **shared** with the network share \texttt{sapmnt}
      
      The global host is the host where the SCS and primary application server instance is installed. On global hosts, the \texttt{\textbackslash usr\textbackslash sap} directory contains general SAP software, global and local (instance-specific) data.
      
      For this, the following directories are created in \texttt{\textbackslash usr\textbackslash sap<SAPSID>\SYS}:
      \begin{itemize}
        \item **global** (contains globally shared data)
        \item **profile** (contains the profiles for all instances)
        \item **exe** (contains executable replication directory for all instances and platforms)
      \end{itemize}
      
      All instances of an SAP system access this directory on the global host using the Universal Naming Convention (UNC) path.
    \item **Local** host and **shared** with the network share \texttt{saploc}.
      
      On local hosts, the \texttt{\textbackslash usr\textbackslash sap} directory contains copies of the SAP software and local (instance-specific) data.
      
      The executables on the local host are replicated from those on the global host each time the local instance is started.
  \end{itemize}
\end{itemize}
7.6 SAP Directories

Only valid for: HA (MSCS)

In MSCS this directory is located on a local disk. You have at least two disk drives with a `\usr\sap` directory structure.

End of: HA (MSCS)

Note

Since SAP traces for the instance are created in a subdirectory of `\usr\sap`, make sure there is sufficient space available in this directory.

- `\usr\sap\trans`

  The transport directory contains SAP software for the transport of objects between SAP systems. SAPinst by default creates it on the `SAPGLOBALHOST`.

  If you want to have it created on another host, or if you want to use an already existing transport host of your SAP system landscape, you can specify another host during the installation. In this case, you have to prepare that host to allow the new SAP system to use it as transport host. For more information, see Preparing the SAP System Transport Host [page 53].

Directory Structure

The global host has the `\<SAPGLOBALHOST\>\SYS` directory structure. The global data is stored in the global directories on the global host and physically exists only once for each SAP system. Other application servers access the global data using the UNC path `\<SAPGLOBALHOST\>\sapmnt`. The SAP programs access their instance-specific data with the UNC path `\<SAPLOCALHOST\>\saploc`. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory.

In a distributed system, the parameters `SAPGLOBALHOST` and `SAPLOCALHOST` have the same values on the global host.

Every time an instance starts, the SAP copy program `sapcpe` compares the binaries in the `<platform>-directory on the global host and the binaries in the <exe>-directory on the application server. If the binaries in the <exe> directory differ from those in the <platform>-directory, `sapcpe` replaces them with the newer version of the global host.

The following figures show how the physical directory `\usr\sap` is shared on the global host in a standard and in a distributed system. In both cases, the UNC paths are used as follows:

- `\<SAPGLOBALHOST\>\sapmnt` to access global directories
- `\<SAPLOCALHOST\>\saploc` to access local instance-specific data
Figure 7: Directory Structure on the Global Host in a Standard (Central) Java System

Figure 8: Directory Structure for a Distributed Java System
7.7 Additional Information About SAPinst

The following sections provide additional information about SAPinst [page 66]:

- Interrupted Installation with SAPinst [page 99]
- Performing a Remote Installation with SAPinst (Optional) [page 101]
- Starting SAPinst GUI Separately (Optional) [page 102]
- Entries in the Services File Created by SAPinst [page 104]
- How to Avoid Automatic Logoff by SAPinst [page 104]
- Troubleshooting with SAPinst [page 105]

7.7.1 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

- An error occurred during the dialog or processing phase:
SAPinst does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description about the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

You interrupted the installation by choosing Exit in the SAPinst menu.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Retry   | SAPinst retries the installation from the point of failure without repeating any of the previous steps.  
This is possible because SAPinst records the installation progress in the keydb.xml file.  
We recommend that you view the entries in the log files, try to solve the problem and then choose Retry.  
If the same or a different error occurs again, SAPinst displays the same dialog box again. |
| Stop    | SAPinst stops the installation, closing the dialog box, the SAPinst GUI, and the GUI server.  
SAPinst records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below. |
| Continue| SAPinst continues the installation from the current point.                                                                           |

**Procedure**

This procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Mount your Installation Master DVD.
3. Restart SAPinst by double-clicking sapinst.exe You can also start SAPinst by entering the following commands at the Windows command prompt:
   
   cd <DVD drive>:\IM WINDOWS<platform>

4. From the tree structure in the Welcome screen, select the installation option that you want to continue and choose Next.

   **Note**
   
   If there is only one component to install, the Welcome screen does not appear.

5. In the What do you want to do? screen, decide between the following alternatives and confirm with OK.
### 7.7.2 Performing a Remote Installation with SAPinst (Optional)

You use this procedure to install your SAP system on a remote host. In this case, SAPinst and the GUI server run on the remote host, and SAPinst GUI runs on the local host. The local host is the host from which you control the installation with SAPinst GUI.

**Prerequisites**

- The remote host meets the prerequisites before starting SAPinst as described in Running SAPinst [page 66].
- Both computers are in the same network and can “ping” each other.
  
  To test this:
  - Log on to your remote host and enter the command `ping <local host>`.  
  - Log on to the local host and enter the command `ping <remote host>`.

**Procedure**

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Insert the Installation Master DVD in the DVD drive on your remote host.
3. Enter the following commands:
   ```plaintext
   cd <DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>
   sapinst.exe -nogui
   ```
   For more information, see Running SAPinst [page 66].
   
   SAPinst now starts and waits for the connection to the SAPinst GUI. You see the following at the command prompt:
   ```plaintext
   guiengine: no GUI connected; waiting for a connection on host <host_name>, port <port_number> to continue with the installation
   ```
   
4. Start SAPinst GUI on your local host, as described in Starting SAPinst GUI Separately [page 102].
7.7.3 Starting SAPinst GUI Separately (Optional)

You use this procedure to start SAPinst GUI separately. You might need to start SAPinst GUI separately in the following cases:

- You have logged off from SAPinst.
  - If you logged off during the installation and you later want to reconnect to the installation while it is still running, you can start SAPinst GUI separately.
- You want to perform a remote installation [page 101].
  - If SAPinst GUI runs on a different host from SAPinst and the GUI server, you have to start SAPinst GUI separately.

Starting SAPinst GUI on a Windows Platform

1. Log on as a member of the local administrators group.
2. Insert the SAP Installation Master DVD into your DVD drive.
3. Change to the directory of the sapinst executables:
   `<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>_<DB>`

   ![Note]
   If you want to start SAPinst GUI on a Windows 32-bit platform, change to the following directory:
   `<Installation_Master_DVD>\DATA_UNITS\SAPINSTGUI_710_WINDOWS_I386`

4. Start SAPinst GUI by double-clicking `sapinstgui.exe`
   SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.
   If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.
   In this case, enter the name of the host on which SAPinst is running and choose Log on.
   The first dialog of the installation appears and you can perform the remote installation from your local host.

   ![Note]
   Optionally you can start `sapinstgui.exe` with the following parameters:
   - `host=<host name>`, where `<host name>` is the host name of the installation host
   - `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
   - `-accessible` enables the Accessibility mode
   Example:
   `./sapinstgui.exe host=lsi1209 port=3000 -accessible`
Starting SAPinst GUI on a UNIX Platform

1. Log on as user root.

**Caution**
Make sure that the root user has not set any environment variables for a different SAP system or database.

2. Mount your Installation Master DVD.

**Note**
Mount the DVD locally. We do **not** recommend that you use Network File System (NFS).

3. Change to the directory of the sapinst executables:
   `<Installation_Master_DVD>/DATA_UNITS/IM_<OS>_<DB>`

**Note**
If you want to start SAPinst GUI on a Linux 32-bit platform, change to the following directory:
   `<Installation_Master_DVD>/DATA_UNITS/SAPINSTGUI_710_LINUX_I386`

4. Start SAPinst GUI by executing `.sapinstgui`
   SAPInst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.
   If SAPinst and the GUI server are running on another host, SAPInst GUI cannot connect and the `SAP_Installation GUI Connection` dialog appears.
   In this case, enter the name of the host on which SAPinst is running and choose *Log on.*
   The first dialog of the installation appears and you can perform the remote installation from your local host.

**Note**
Optionally you can start `sapinstgui` with the following parameters:
- `host=<host name>`, where `<host name>` is the host name of the installation host
- `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
- `- accessible` enables accessibility mode
Example:
   `.sapinstgui host=lsi1209 port=3000 -accessible`
7.7.4 Entries in the Services File Created by SAPinst

After the installation has finished successfully, SAPinst has created the following entries for port names in `<drive>\WINDOWS\system32\drivers\etc\services`:

- `sapdpXX` = `32XX/tcp`
- `sapdbXXs` = `47XX/tcp`
- `sapgwXX` = `33XX/tcp`
- `sapgwXXs` = `48XX/tcp`

where XX is set from 00 to 99.

**Note**

If there is more than one entry for the same port number, this is not an error.

7.7.5 How to Avoid Automatic Logoff by SAPinst

When you install the SAP system with SAPinst, the SAPinst installation tool checks whether the user account used for the installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local **Administrators** and the domain **Admins** group. For a local installation, the account needs to be a member of the local **Administrators** group.

In both cases, the user account must be authorized to:

- Act as part of the operating system
- Adjust memory quotas for a process
- Replace a process-level token

If the user account does not have these rights assigned, SAPinst automatically logs the account off to assign them. To avoid SAPinst logging the account off, you can set these rights manually before you start the installation.

**Procedure**

You perform the following steps to assign these rights to the user account used for the installation.

**Caution**

Be aware that domain policies override locally defined policies. This means that if you want to grant domain administrator rights for a user who belongs to the local **Administrators** group, make sure that you have also defined domain administrator rights for this user on domain level.

1. Choose **Start** ➤ **Settings** ➤ **Control Panel** ➤ **Administrative Tools** ➤ **Local Security Policy** ➤
2. In the **Local Security Settings** window, choose **Local Policies** ➤ **User Rights Assignment** ➤
3. Double-click the required right under **Policy** and choose **Add User or Group**.
4. In the Select Users and Groups window, choose the required user and choose Add. The selected user appears in the box below.

5. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the installation.

6. Log off and log on again to apply the changes.

More Information
Required User Authorization for the Installation [page 49]

7.7.6 Troubleshooting with SAPinst

This section tells you how to proceed when errors occur during the installation with SAPinst.

If an error occurs, SAPinst:

- Stops the installation
- Displays a dialog informing you about the error

Procedure

1. To view the log file, choose View Logs.
2. If an error occurs during the dialog or processing phase, do one of the following:
   - Try to solve the problem.
   - Abort the installation with Exit.
   For more information, see Interrupted Installation with SAPinst [page 99].
   - Continue the installation by choosing Retry.
3. Check the log and trace files of the GUI server and SAPinst GUI in the directory
   %userprofile%\sdtgui\ for errors.
4. If GUI server or SAPinst GUI do not start, check the file sdtstart.err in the current
   %userprofile% directory.
5. If SAPinst GUI aborts during the installation without an error message, restart SAPinst GUI as
described in Starting SAPinst GUI Separately.

7.8 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation with
the SAP Microsoft Management Console (SAP MMC).

With a newly installed MMC you can start or stop installed SAP instances locally on the host that you
are logged on to. If the MMC is configured for central system administration, you can start or stop
the entire system from a single host.
7.9 SAP System Security on Windows

Note
For more information, see:
http://help.sap.com/<your product> ▶ SAP NetWeaver Library ▶ Function-Oriented View ▶ Application
Server ABAP ▶ Administration Tools for AS ABAP ▶ Monitoring in the CCMS ▶ Microsoft Management Console:
Windows

Prerequisites
- You have logged on to the SAP system host as user <sapsid>adm.
- You have checked the settings for VM parameters as described in SAP Note 723909.

Procedure
1. Start the SAP MMC on the SAP system host by choosing ▶ Start ▶ All Programs ▶ SAP Management
   Console 4 i.
2. Right-click the SAP system node and choose Start or Stop.
   All instances listed under the system node, will start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed system), you have the following
   options to start or stop your system:
   You have the following options to start or stop your system:
   - You start or stop the SAP instances using the MMC on each host.
   - You add the remote instances to the MMC configuration to start or stop all instances from
     a single MMC.
     To do so, you configure the MMC manually. For more information, see Changing the Configuration
     of the MMC in the SAP MMC documentation.

Note
You can also start and stop a UNIX system with the MMC.

Note
You can also start and stop an SAP instance on UNIX with the MMC.

7.9 SAP System Security on Windows

In a standard SAP system installation, SAPinst automatically performs all steps relevant for security.
Although SAPinst makes sure that the system is protected against unauthorized access, you must
still check that no security breaches can occur.
For central and straightforward administration of the SAP system, you have to install distributed SAP
systems with multiple application servers in a Windows domain. This section describes the user
accounts and groups that SAPInst creates during a domain installation and shows how these are related to the SAP directories.

**User Accounts**

SAPInst creates the following accounts for SAP system administration:

- **<sapsid>adm**
  This is the SAP system administrator account that enables interactive administration of the system.

- **SAPService<SAPSID>**
  This is the user account that is required to start the SAP system. It has the local user right to log on as a service.
  The advantage of the additional SAPService<SAPSID> account is that it does not allow an interactive logon, which prevents abuse of the account. Therefore, you do not need to set an expiration date for the password and you do not have to set the option *user must change password at next logon*.

- **sapadm**
  This is the user for the SAP host agent. It is a member of the local Administrators group.
  The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator.

**Groups**

SAPInst creates the following groups during a domain installation:

- **SAP_<SAPSID>_GlobalAdmin**
  This global group is a domain-level SAP administration group for organizing SAP system administrators. The only function of a global group is to group users at the domain level so that they can be placed in the appropriate local groups.

- **SAP_<SAPSID>_LocalAdmin**
  Only local groups are created and maintained on an application server. A local group can only be given permissions and rights to the system where it is located. The system is part of a particular domain, and the local group can contain users and global groups from this domain.

- **SAP_LocalAdmin**
  This group is created on all hosts, but is particularly important for the transport host. Members of the group have full control over the transport directory (`\usr\sap\trans`) that allows transports to take place between systems.
  The SAP_<SAPSID>_GlobalAdmin groups of all the SAP systems that are part of the transport infrastructure are added to the SAP_LocalAdmin group. As a consequence, the users <sapid>adm and SAPService<SAPSID> of all systems in the transport infrastructure are members of the SAP_LocalAdmin group and have the required authorizations necessary to initiate and execute transports.
**SAP Directories**

SAPinst protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group `SAP_<SAPSID>_LocalAdmin` full control over these directories. The following graphic illustrates the user accounts and groups created by SAPinst in a system infrastructure consisting of two SAP systems.

**Figure 10:** User Groups and Accounts

![Diagram illustrating user groups and accounts created by SAPinst](image)

**Note**

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:

- Local group `SAP_<SAPSID>_LocalAdmin`
- Group Administrators
- Account SYSTEM

### 7.10 Automatic Creation of Accounts and Groups

SAPinst automatically creates the accounts and groups required for the secure operation of the SAP system with Windows [page 106] during the installation.
Features

The following figures show the steps that SAPinst performs to create the users and groups and assign the required rights to SAP directories.

Figure 11: Creating Users and Groups

<table>
<thead>
<tr>
<th>Creation of Accounts</th>
<th>Creation of SAP user accounts</th>
<th>SAP Administrator (&lt;\text{sapSID}&gt;_\text{adm})</th>
<th>SAP Service Account (&lt;\text{sapSID}&gt;_\text{SAPService})</th>
<th>SAP Host Agent Account (&lt;\text{sapSID}&gt;\text{sapadm})</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation and Modification of Global Group in the Domain</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation of global group (&lt;\text{sapSID}&gt;\text{GlobalAdmin})</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Addition of (&lt;\text{sapSID}&gt;<em>\text{adm}) and (&lt;\text{sapSID}&gt;</em>\text{SAPService}) to group (&lt;\text{sapSID}&gt;\text{GlobalAdmin})</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Addition of (&lt;\text{sapSID}&gt;_\text{adm}) to the local Administrators group</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Addition of (&lt;\text{sapSID}&gt;_\text{adm}) to the Windows domain user groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation and Modification of Local Group on Each Application Server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation of the local group (&lt;\text{sapSID}&gt;\text{LocalAdmin}) on the application server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Addition of the global (&lt;\text{sapSID}&gt;\text{GlobalAdmin}) to the local group (&lt;\text{sapSID}&gt;\text{LocalAdmin})</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation of the local group (&lt;\text{sapSID}&gt;_\text{LocalAdmin}) on the application server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Addition of the global group (&lt;\text{sapSID}&gt;\text{GlobalAdmin}) to the local group (&lt;\text{sapSID}&gt;_\text{LocalAdmin}) on the application server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Addition of the (&lt;\text{sapSID}&gt;\text{GlobalAdmin}) group to the local group (&lt;\text{sapSID}&gt;_\text{LocalAdmin}) on the transport host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
7.11 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.

Uninstalling SAP NetWeaver CE
Choose ➤ Start ➤ Control Panel ➤ Add / Remove programs ➤ SAP System <SAPSID> ➤.

Uninstalling SAP NetWeaver CE Using SAPinst

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section Installing SAP NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

Uninstalling the SAP Management Console
Since all SAP systems use the SAP Management Console, there is no uninstallation option for the SAP Management Console with SAPinst. If you are sure that you do not need the SAP Management Console any more, you can remove it using ➤ Start ➤ Control Panel ➤ Add / Remove programs ➤.
7.12 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the Uninstall option of SAPinst.

Caution

- You cannot delete an SAP system remotely.
- If you delete network-wide users, groups or service entries in an environment with Network Information System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service entries to be deleted are no longer required.

Prerequisites

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the SAPinst tool and the SAP system. For more information, see Required User Authorization for the Installation [page 49].

Procedure

1. Start SAPinst and on the Welcome screen, choose:
   < SAP System > | Software Life-Cycle Options | Uninstall | Uninstall – SAP systems or single instances.
2. Follow the instructions in the SAPinst input dialogs.

Note

For more information about the input parameters, place the cursor on the relevant field and press F1 in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.

- If you want to delete a standard system (all instances reside on the same host), you can do this in one SAPinst run.

  Note

  SAPinst deletes the database instance but you have to delete the MS SQL Server database software with the SQL Server Uninstaller, which you can find on Windows at Add/Remove Programs.

- If you want to delete a distributed system, you have to run SAPinst to delete the required instances locally on each of the hosts belonging to the SAP system in the following sequence:
  a) Additional application server instance(s), if there are any
b) Database instance

⚠️ Caution
SAPinst only stops local instances automatically. Before you delete the database instance of a distributed system make sure that you stop all remaining instances. You must stop the instance with the message server only after having entered all SAPinst parameters for the deletion of the database instance.

💡 Note
With this SAPinst option you do not delete the database software.

c) Primary application server instance

💡 Note
If SAPinst stops responding while trying to delete the primary application server instance, close SAPinst with Cancel and Exit. Log off and log on again. To complete the uninstall process of the primary application server instance, restart SAPinst.

d) Central services instance

3. When you have finished you can delete the MS SQL Server database software using the SQL Server Uninstaller, which you can find on Windows at Add/Remove Programs.

4. If required, you can delete the directory \usr\sap\trans and its contents manually. SAPinst does not delete \usr\sap\trans because it might be shared.
You can install a high-availability SAP system with Microsoft Cluster Service (MSCS). For this type of installation, you have to set up the system on at least two clustered hosts (called “MSCS nodes”) and configure it so that it can take advantage of the MSCS software. The MSCS software improves the availability of the system and safeguards it against failure and unplanned downtime, enabling 24-hour operation, 365 days a year.

With high availability you enable critical system components, called Single Points of Failure (SPOFs), to be automatically switched from one machine to the other in the event of hardware or software problems affecting one machine. With the help of this switchover — or failover — the system can continue functioning normally so that unplanned system downtime is avoided.

Apart from enabling failover when hardware problems occur, you can also use MSCS to avoid downtime when you perform essential system maintenance. If you need to maintain one node, you can deliberately switch the cluster resources to another node and temporarily operate it there while maintenance is in progress. When maintenance work is finished you can easily move the resources back to their original node and continue operating them there.

Until now, SAP has only supported the installation of one clustered SAP system in one MSCS cluster with two MSCS nodes. Now you have the following options to install a high-availability system with MSCS to safeguard it against failure and unplanned downtime:

- You install one SAP system in one MSCS cluster.
- You install one SAP system in two MSCS clusters.
- You install several SAP systems in one or more MSCS cluster(s) with two and more MSCS nodes.

For all MSCS configurations the following restrictions apply:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If your database supports the installation on several MSCS nodes, you can install the database instance on more than two MSCS nodes in one MSCS cluster.
Caution

The following conditions for SAP support apply to:

- One clustered SAP system in one MSCS cluster with two MSCS nodes or one clustered SAP system in two MSCS clusters
  If you have one of these MSCS configurations and you use SAPinst to install such an MSCS system, you get SAP support with the installation, configuration, and operation.
- Multiple SAP systems with one or more MSCS cluster(s) and two or more MSCS nodes
  For such complex MSCS systems you need in-depth knowledge of and experience with the Windows operating system, the Microsoft Cluster Service, the sizing and clustering of an SAP system. Therefore, the **sizing, installation and configuration** of such an MSCS system **must** be performed by an SAP Global Technology Partner, who supports any installation and configuration problems that arise from this MSCS configuration.
  Only then does SAP support the operation of this MSCS system.

Note

- Make sure that you read SAP Note [965569](#), which contains the most recent information as well as corrections for MSCS. For more information, see the SAP installation notes [page 9](#) before you begin the installation.
- In this documentation the hosts in an MSCS cluster are referred to as first MSCS node and additional MSCS node(s).
  The **first MSCS** node is the MSCS node where you perform the general installation of an SAP system, for example where the database or (A)SCS instance is to be installed.
  The **additional MSCS node** is the node where you configure the already installed SAP instances to run in MSCS.

To install a new SAP system with MSCS, you combine general installation steps, described earlier in this documentation, with cluster-specific steps described here:

- You cluster the SQL Server already when you install the database software.
- Since the cluster hardware has at least two nodes that have access to all local and shared storage devices, you have to install some components on all MSCS nodes and observe special rules for distributing components to local or shared disks.
- Since the correct configuration of network addresses is absolutely essential to enable the cluster to function properly, you have to perform a number of additional steps that are necessary to set up and check addressing.
**8.1 Planning**

You have to complete the following planning activities for you SAP system using Microsoft Cluster Service (MSCS):

1. You check the general planning activities [page 13] listed in Chapter 2 of this guide.
2. You decide how to set up your SAP system components in an MSCS configuration [page 115].
3. You decide how to distribute components to disks for MSCS [page 123].
4. You read Directories in an MSCS Configuration [page 126].
5. You read IP Addresses in an MSCS Configuration [page 127].
6. You obtain IP addresses for MSCS [page 130].

### 8.1.1 System Configuration in MSCS

The following chapters provide information about the configuration of your SAP system configuration in MSCS. It describes the components you have to install for one or more SAP system running in one cluster, and how to distribute them on the specific host. For more information, see:

- SAP System Components in an MSCS Configuration [page 115]
- Multiple SAP Systems in one MSCS Cluster [page 118]
- Multiple SAP Systems Inside Multiple MSCS Cluster [page 121]
- Enqueue Replication Server in MSCS [page 122]

### 8.1.1.1 SAP System Components in an MSCS Configuration

In an MSCS configuration you have the following mandatory components for your SAP system:
SAP System Components in an MSCS Configuration

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components per SAP System</th>
<th>Single Point of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS instance (message services and enqueue services)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Database instance</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Application server instance (primary application server, additional application server)</td>
<td>1-n</td>
<td>no</td>
</tr>
</tbody>
</table>

- To protect the SPOFs ((A)SCS instance and database instance) you have to use MSCS.
  If a hardware or software problem occurs on the first MSCS node, the clustered (A)SCS instance and the clustered database automatically fail over to another node.
  If you need to maintain the MSCS node where the (A)SCS instance and database are running you can switch these instances to another node. When maintenance work is finished you move the (A)SCS and database instance back to the original node.
  
- To protect system components that are non-SPOFs, for example application servers, you have to install them as multiple components. In this case you must install at least two application servers (the primary application server instance and one additional application server instance) on two different hosts. You have the following options:
  - You install the primary application server and the additional application server instance on the MSCS nodes of an MSCS cluster. You install them on a local disk. Any additional application server instances are installed on hosts outside of the MSCS cluster.
    If you have to maintain an MSCS node, you have to stop the primary application server or the additional application server instance on that node. When you have finished maintenance, you restart the instance(s).
  - You install the primary application server and all additional application server instances on hosts, which are not part of an MS cluster.

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in an MSCS cluster with two nodes.

The first figure shows an MSCS configuration where the non-SPOFs components (primary application server instance, additional application server instance) are installed locally on the MSCS nodes. Any additional application server instance(s) are installed outside the MSCS cluster on separate hosts.
The following figure shows an MSCS configuration, where the non-SPOFs components (primary application server instance, additional application server instance) are installed on separate hosts that are not part of the MS cluster.
SAP System Components in Two MSCS Clusters
Besides installing your SAP system in one MSCS cluster, you can also set up two MSCS clusters and distribute the SPOF system components on these clusters to protect them against system failure.
The following figure shows an example where the database instance for the SAP system is installed in one MSCS cluster, and the (A)SCS instance is installed on the second MSCS cluster. The application servers (primary application server instance, additional application server instance) can either be installed on a local disk on the MSCS nodes or on separate hosts that are not part of the MS cluster.

Figure 15: Java System

8.1.1.2 Multiple SAP Systems In One MSCS Cluster

⚠️ Caution
For such a complex MSCS system you need in-depth knowledge of and experience with the Windows operating system, the Microsoft Cluster Service, the sizing and clustering of an SAP system.
Therefore, the installation and configuration of such an MSCS system must be performed by an SAP Global Technology Partner, who supports any installation and configuration problems that arise from this MSCS configuration. Only then does SAP support the operation of multiple SAP systems in one MSCS cluster.

Until now, SAP has only supported the installation of one clustered SAP system in one MSCS cluster with two MSCS nodes. This was due to the fact that the cluster share sapmnt resource could only be assigned to one cluster group and could only point to one shared drive. However, additional
clustered SAP systems require additional cluster groups, shared disks, and a unique IP and network name, as well as an sapmnt share. Adding an additional sapmnt share is not possible as it already exists and points to the shared disk of the first clustered SAP system. The solution is to rename the cluster share sapmnt resource into sapmnt<SAPSID>.

On the local disk, which must have the same disk letter on all MSCS nodes, you create the usr\sap\<SID> folders on all nodes and set the saploc and sapmnt shares on usr\sap. Then you create junctions on the local disk pointing to the relevant SYS and <Instance><Number> folders on the shared disk(s) on all nodes.

⚠️ Caution

All additional local instances like an enqueue replication server, first or additional application server instance are installed on the local disk where the saploc share is pointing to. Make sure that you have enough space on this local disk.

With this configuration, every SAP system is placed in a separate MSCS cluster group with the unique name SAP <SAPSID> having its own shared disk, IP address, network name, sapmnt<SID> share as well as the Windows generic service and the SAP resource. SAP cluster groups belonging to different SAP systems are running separately and independent from each other.

If you have such an MSCS configuration with three and more MSCS nodes, the following restrictions:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If the database supports the installation on several MSCS nodes, the database instance can be installed on more than two MSCS nodes in one MSCS cluster.

The following figure shows the installation of multiple SAP systems in one MSCS cluster. For each SAP system you have to install one primary and at least one additional application server.
The following table shows what additional SAP systems you can install in one MSCS cluster if you already have a clustered SAP system.

Multiple SAP Systems in One MSCS Cluster

<table>
<thead>
<tr>
<th>First Clustered System</th>
<th>Additional SAP System(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- SAP NetWeaver 7.1 based ABAP system (kernel 7.10)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based Java system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP+Java system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver ’04 SR1 based ABAP system (kernel 6.40, ABAP Patch Level 90)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver ’04 SR1 based Java system (kernel 6.40, SP 18)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver ’04 SR1 based ABAP+Java system (kernel 6.40, SP 18)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.1 based ABAP system(s) (kernel 7.10)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based Java system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP+Java system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.1 based ABAP system (kernel 7.10)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based Java system (kernel 7.00)</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP+Java system (kernel 7.00)</td>
<td></td>
</tr>
</tbody>
</table>

ASCS = ABAP Central Services Instance  
SCS = Central Services Instance  
PAS = Primary Application Server Instance  
AAS = Additional Application Server Instance
8.1.1.3 Multiple SAP Systems In Multiple MSCS Clusters

Besides installing multiple SAP systems in one MSCS cluster, it is also possible to install multiple SAP systems in several MSCS clusters with two or more MSCS nodes.

Note
The MSCS software supports up to eight MSCS nodes.

Caution
For such a complex MSCS system you need in-depth knowledge of and experience with the Windows operating system, the Microsoft Cluster Service, the sizing and clustering of an SAP system. Therefore, the installation and configuration of such an MSCS system must be performed by an SAP Global Technology Partner, who supports any installation and configuration problems that arise from this MSCS configuration. Only then does SAP support the operation of multiple SAP systems in multiple MSCS clusters.

For this MSCS configuration the following restrictions apply:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If the database supports the installation on several MSCS nodes, the database instance can be installed on more than two MSCS nodes in one MSCS cluster.

The following figure shows the installation of multiple SAP systems in two MSCS clusters with three nodes, called Node A, B and C. In this example, the SCS and ASCS instances are installed in the first MSCS cluster, and the database instances for the two SAP systems are installed on the second MSCS cluster. The primary and additional application servers can be either installed on a local disk on the MSCS nodes or outside the MSCS cluster on separate hosts.

Note
If you use an enqueue replication server, you must install the enqueue replication server, and the
(A)SCS instance on two nodes.

**Figure 17**: Multiple SAP Systems in Two MSCS Clusters

![Diagram of MSCS Clusters](image)

**8.1.1.4 Enqueue Replication Server in an MSCS Configuration**

The enqueue replication server contains a replica of the lock table (replication table) and is an essential component in a high-availability setup. It is required for a Java system, but also strongly recommended for an ABAP system.

You have to install the enqueue replication server on the two MSCS nodes where the (A)SCS instance is installed and configured to run, even if you have more than two MSCS nodes.

In normal operation the replication enqueue server is always active on the host where the (A)SCS instance is not running.

If an enqueue server in an MSCS cluster with two nodes fails on the first MSCS node, the enqueue server on the additional MSCS node is started. It retrieves the data from the replication table on that node and writes it in its lock table. The enqueue replication server on the second MSCS node then becomes inactive. If the first MSCS node is available again, the enqueue replication server on the second MSCS node becomes active again.

The following figure shows the enqueue replication server mechanism in an MSCS configuration with two nodes:
8.1.2 Distribution of SAP System Components to Disks for MSCS

One of the central points to keep in mind when planning the MSCS installation is that the cluster hardware has two different sets of disks:

- Local disks that are connected directly to the MSCS node(s)
- Shared disks that can be accessed by all MSCS nodes via a shared interconnect

**Note**

Shared disk is a synonym for the MSCS resource of Resource type **Physical disk**.

You need to install the SAP system components in both the following ways:

- Separately on all MSCS nodes to use the local storage on each node.
- On the shared storage that is used in common by all MSCS nodes.

You install the following on **different** shared disks:

- Database data files
- Database shared binaries
- SAP system executables
- Single quorum device, if used
With Windows Server 2003, you can now choose between the following cluster models:

- **Single Quorum Device Cluster**
  - In this cluster model the quorum resource maintains the cluster configuration data on a single cluster storage device.
  - The quorum resource is unique to a cluster installation and is always owned by one of the nodes.
  - It has the following main functions in the cluster:
    - It logs changes to the cluster configuration that are entered in the Registry.
    - It arbitrates between competing nodes when the communication between nodes breaks down.
      - This means that cluster resources are forced to fail over to the node that owns the quorum resource.

- **Majority Node Set Cluster**
  - In this new cluster model, each node maintains its own copy of the cluster configuration data.
  - The Majority Node Set resource, acting as the Quorum Resource, ensures that the cluster configuration data is kept consistent across the different nodes.
  - You can use majority node set for geographically dispersed cluster configuration.
  - SAP supports Majority Node Set Cluster if it is part of a cluster solution offered by your Original Equipment Manufacturer (OEM), or Independent Hardware Vendor (IHV).

The following figures show a cluster configuration for one and for multiple SAP systems, where the (A)SCS and DB instance are installed in the same cluster. It illustrates how to distribute the database data files, the SAP system executables, and the quorum resource (if used) to **different** disks. Only with this distribution of files to distinct disks is it possible to move the SAP system and database as separate entities in a failover situation.
Figure 19: Distribution of SAP System Components For One SAP System in MSCS

Figure 20: Distribution of SAP System Components For Multiple SAP Systems in MSCS
More Information

Directories in an MSCS Configuration [page 126]

8.1.3 Directories in an MSCS Configuration

The following tables show the directories where the main software components for the SAP cluster installation are stored:

Directories on Local Disks on MSCS Nodes

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>A supported operating system</td>
<td>%windir%</td>
</tr>
<tr>
<td>MSCS software</td>
<td>%windir%\Cluster</td>
</tr>
<tr>
<td>SAP cluster files</td>
<td>%windir%\SAPCluster</td>
</tr>
<tr>
<td>Junctions for multiple SAP systems in one MSCS</td>
<td>&lt;local_drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;n&gt;[Junction]</td>
</tr>
<tr>
<td>Application server (if installed locally)</td>
<td>&lt;local_drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;Instance&gt;</td>
</tr>
</tbody>
</table>

Directories on Shared Disks

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster quorum resource (if used)</td>
<td>&lt;drive&gt;:\MSCS</td>
</tr>
<tr>
<td>SAP global and instance directories</td>
<td>&lt;drive&gt;:\usr\sap ...</td>
</tr>
<tr>
<td>tempdb databases</td>
<td>&lt;drive&gt;:\TEMPDB</td>
</tr>
<tr>
<td>msdb, model, master, shared binaries</td>
<td>&lt;drive&gt;:\mssql</td>
</tr>
<tr>
<td>SAP data files</td>
<td>&lt;drive&gt;:&lt;SAPSID&gt;DATA0</td>
</tr>
<tr>
<td></td>
<td>&lt;drive&gt;:&lt;SAPSID&gt;DATA1</td>
</tr>
<tr>
<td></td>
<td>&lt;drive&gt;:&lt;SAPSID&gt;DATA2</td>
</tr>
<tr>
<td></td>
<td>&lt;drive&gt;:&lt;SAPSID&gt;DATA3</td>
</tr>
<tr>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>&lt;drive&gt;:&lt;SAPSID&gt;DATA&lt;n&gt;</td>
</tr>
<tr>
<td>SAP log files</td>
<td>&lt;drive&gt;:&lt;SAPSID&gt;log&lt;n&gt;</td>
</tr>
</tbody>
</table>

SapCluster Directory

In an SAP cluster installation, an additional directory – %WINDIR%\SapCluster – is created under the system directory.

This contains all the SAP files required by all MSCS cluster nodes, independently of the MSCS node the SAP instance is running on. The files are database tools and program files (executables) used by the operating system monitor (SAPOsCol).

The directory is added to the path variable of the user <sapsid>adm.
8.1.4 IP Addresses in an MSCS Configuration

A part of the installation process that is unique to MSCS is the configuration of host names and IP addresses in the network. This is a particularly important task because the addressing plays a key role in the switchover procedure. Addressing must be set up correctly so that the system can take advantage of the cluster functionality and switch between nodes when hardware problems arise. This section explains the different types of IP addresses and their function in the switchover mechanism of one MSCS cluster with two MSCS nodes.

Types of IP Addresses
In a correctly configured cluster with at least two nodes, there are at least seven IP addresses and corresponding host names for your SAP system.
You have two IP addresses for each MSCS node, one IP address for the cluster, one address for the SAP cluster group and one for the database cluster group.
Some of the addresses are assigned to the network adapters (cards), others are virtual IP addresses that are assigned to the cluster groups.

Physical IP Addresses Assigned to Network Adapters
An MSCS configuration usually has two networks:

- A public network that is used for the communication between the primary application server, additional application servers and the LAN.
- A private network that is used internally for communication between the nodes of the cluster.

Note
For more information on network configuration, see also the Microsoft Knowledge Base Article 259267.

The following figure shows an MSCS cluster with two nodes and illustrates the adapters required for the public and private networks, and their corresponding physical IP addresses. A physical IP address, as opposed to a virtual one, is stationary and permanently mapped to the same adapter.
**Figure 21:** Adapters and IP Addresses Required for Public and Private Networks in an MSCS Cluster with Two Nodes

![Diagram showing IP addresses and host names for public and private networks in an MSCS cluster with two nodes.]

### Host Names Assigned to Network Adapters

Each of the physical IP addresses of the network adapters must have a corresponding host name. For example, on the left-hand node in the figure above, you might assign the IP addresses of the public and private network adapters as follows:

### IP Addresses and Host Names

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 1 (private network)</td>
<td>10.1.1.1</td>
<td>clusAPriv</td>
</tr>
<tr>
<td>Adapter 3 (public network)</td>
<td>129.20.5.1</td>
<td>clusA</td>
</tr>
</tbody>
</table>

**Caution**

- The IP address and host name of the **public** network adapter is also the IP address and name of the machine. In our example, this means that the machine that is the MSCS node on the left in the figure has the name **clus1**.
- Do **not** confuse the **host name** with the **computer name**. Each node also has a computer name, which is often the same as the host name.

The computer name is displayed in the node column of the Cluster Administrator. However, it is **not** required for the TCP/IP communication in the cluster. When you configure IP addresses and corresponding names, keep in mind that it is the **host names** that are important for the
cluster, not the computer names.

Virtual IP Addresses Assigned to Cluster Groups

When you have installed the SAP system and fully configured the cluster, the critical system resources are bound together in three different groups. Each of these groups requires a virtual IP address and host name that is permanently mapped to the group and not to a particular node. This has the advantage that, whenever a group is moved between nodes, its IP address and host name move together with it.

⚠️ Caution

If you have more SAP systems in the same MSCS cluster, you need for each system an extra IP address and network name for the SAP and database cluster group.

An MSCS configuration has the following groups:

- SAP cluster group for each clustered SAP system
- Database cluster group for each clustered SAP system
- Cluster group

Each group consists of a set of related resources that work together to offer a service to the system. For example, the database cluster group comprises all the resources that enable the database server to fulfill the requests of a client. When the group is moved from one node to the other, due to node failure, the virtual IP address and host name move with it. Therefore, there is a failover not only of resources, but also of the virtual IP address and host name. As a result, all clients can still reach the database server with the same IP address as before.

The following figure illustrates how the virtual IP addresses of the database group and SAP group can move from one node to the other when failover occurs.
8.1.5 Obtaining IP Addresses for MSCS

You need to correctly configure IP addresses for a cluster system. During the installation procedure you have to assign at least seven IP addresses and host names. You normally obtain these names and addresses from the system administrator.

Prerequisites

- If you are installing Windows for the first time on your system, follow the procedure Obtaining IP Addresses below.
- If Windows has already been installed on your system, the host names and IP addresses of the network adapters (cards) have already been defined and exist in your system.
  This means that you can find out the IP addresses for the network adapters using the procedure Determining Existing IP Addresses below.
  However, you still need to use the table Virtual IP Addresses in the procedure Obtaining IP Addresses.

Obtaining IP Addresses

Ask the system administrator to give you the addresses and host names listed in the tables below, which shows an example for a configuration with one MSCS cluster with two nodes. You will need to enter the addresses and host names later during the installation process.

The column Defined During indicates at which stage of the installation the addresses are defined in the system.
### Caution

Use the names **exactly** as specified by the system administrator, carefully observing uppercase and lowercase letters.

#### Physical IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Physical IP Address</th>
<th>Example for Physical Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>First MSCS Node: adapter for private network</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
<td>Address for inter-node communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>First MSCS Node: adapter for public network</td>
<td>129.20.5.1</td>
<td>clusA</td>
<td>Address of the first MSCS node for communication with application servers and LAN (this is the same as the address of the first MSCS node)</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional MSCS Node: adapter for private network</td>
<td>10.1.1.2</td>
<td>clusB_priv</td>
<td>Address for inter-node communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional MSCS Node: adapter for public network</td>
<td>129.20.5.2</td>
<td>clusB</td>
<td>Address of the additional MSCS node for communication with application servers and LAN (this is the same as the address of the additional MSCS node)</td>
<td>Windows installation</td>
</tr>
</tbody>
</table>

#### Virtual IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Virtual IP Address</th>
<th>Example for Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster group</td>
<td>129.20.5.3</td>
<td>clusgrp</td>
<td>Virtual address and name of the cluster group. It identifies the cluster and is used</td>
<td>MSCS software installation</td>
</tr>
</tbody>
</table>
Determining Existing IP Addresses
To find out the existing IP addresses and corresponding host names and addresses, proceed as follows:

1. Choose Start ➤ Settings ➤ Network and dial-up Connections.
   The Network and dial-up Connections window appears.
2. Select one of the network cards that are displayed and choose File ➤ Properties.
   A dialog box opens.
   The TCP/IP Properties dialog box appears and shows the IP address of the initially selected network card.
4. To find out the host name that is mapped to the IP address, use the ping command:
   ```
   ping -a <IP_Address>
   ```
   The system returns the host name assigned to the IP address.
   Do not forget to ping your local machine as well.
5. Repeat these steps for the other network cards.

For more information about IP addresses in the cluster environment, see IP Addresses in an MSCS Configuration [page 127].

8.2 Preparation
For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you have to perform the same general preparations as for a distributed system [page 27]. In addition, you have to perform the following MSCS-specific preparation tasks:
1. On all MSCS nodes, you manually assign drive letters to the shared disks [page 133] using the Windows Disk Administrator. All MSCS nodes must access the shared disks with the same drive letters.

2. You map the IP addresses to host names [page 133] on the Domain Name System (DNS) Server or in the hosts file.

3. You check the mapping of host names for MSCS [page 134].

4. If you have already one clustered SAP system, and you want to you use multiple systems in this MSCS cluster, you must adapt the existing SAP system for the installation of multiple systems in one MSCS cluster [page 135].

5. You prepare your system for the installation of multiple SAP systems in one cluster [page 138].

6. Having finished all MSCS-specific preparations, continue with the installation tasks for MSCS [page 141].

Note
To make sure that all preparation steps have been correctly performed, check that you can move the disk resources from one MSCS node to another so that they are only accessible from a single node at any time.

### 8.2.1 Assigning Drive Letters for MSCS

We recommend that you assign drive letters for MSCS. In an MSCS cluster, the shared disks that can be accessed by all nodes via a common bus must be addressed by all nodes with the same drive letters.

**Procedure**

2. Select a disk and choose Action All tasks Change drive.
3. Enter a new drive letter.

### 8.2.2 Mapping Host Names to IP Addresses for MSCS

To enable correct operation of the failover mechanism, you have to map all IP addresses in the MSCS cluster to host names.

The mapping enables the system to translate host names into IP addresses. Host names are normally used for administrative tasks because they are easier to use than the long, numeric IP addresses. However, the system can only respond to host names if they are translated into IP addresses.

**Prerequisites**

- You have installed the Windows operating system.
You have the list of IP addresses [page 130].
You have correctly entered all seven IP addresses required for the MSCS configuration.

Caution
Missing or incorrect entries for the IP addresses can cause problems later during the installation.

Procedure
To map the host names to the IP addresses, do one of the following:

- Map the host names to IP addresses on a Domain Name System (DNS) server.
- Map the IP addresses in the Windows hosts file.
  - The file is located in the default Windows directory:
    %SystemRoot%\System32\Drivers\etc

Recommendation
We recommend that you perform the mapping on the DNS server because this only requires a single entry.
If you perform the mapping in the hosts file, you have to maintain the hosts file on all MSCS nodes of the cluster, and on all application servers and front ends, as each host in the system has its own hosts file.

8.2.3 Checking the Mapping of Host Names for MSCS

You need to check the mapping of host names to IP addresses as otherwise you might have serious problems later.

Prerequisites
You have mapped the host names to the IP addresses [page 133] on the DNS Server or in the hosts file.

Procedure
1. For each IP address enter the following commands:
   a) ping -a <IP_Address>
      - The system returns the host name that is assigned to the IP address.
   b) ping hostname
      - The system returns the IP address that is assigned to the host name.
2. Compare the output with your own record of addresses and host names, and check for the following possible errors:

- Incorrect output of uppercase and lowercase
  Make sure that you correct the error before you proceed with the installation.

- Error in the network bindings
  If you enter the name of the public network adapter, which is usually also the name of the local host, and the system returns the IP address of the private network, there is an error in the network bindings.

  To correct the network bindings, do the following on all MSCS nodes:
  a) Choose Start ➤ Settings ➤ Network and Dial-up Connections ➤

  The Network and Dial-up Connections window appears.

  b) Choose Advanced ➤ Advanced Settings ➤ Adapters and Bindings ➤

  The network cards of the private and public networks are displayed for the current MSCS node.

  Note

  The card of the public network must be displayed before that of the private network. If necessary, change the order in which the cards are listed by using the Move Up and Move Down arrows.

2.4 Preparing an Existing SAP System to Support Multiple Systems in one MS Cluster

If you have already installed an SAP system in a Microsoft cluster, and you want to install an additional SAP system in the same cluster, you have to prepare the existing clustered system to use junctions.

The following sections describe the procedure for the preparation of the:

- (A)SCS instance
- ABAP primary application server instance

Note

As of SAP NetWeaver 7.1, the central instance is called primary application server.
8.2 Preparation

**Prerequisites**
To create the junctions, you need the tool `linkd.exe` from Microsoft. The executable is part of the Microsoft Windows Server 2003 Resource Kit Tools, which you can download from [http://www.microsoft.com](http://www.microsoft.com). Search for *Microsoft Windows Server 2003 Resource Kit Tools*.

![Note]
You can also use the 32-bit executable for 64-bit machines.

**Preparing the (A)SCS Instance**
The following procedure applies for the:
- SCS instance based on one of the following SAP NetWeaver Java systems:
  - SAP NetWeaver 7.1 Java
  - SAP NetWeaver 7.0 SR<x> Java
  - SAP NetWeaver ’04 SR1 Java
- ASCS instance based on one of the following SAP NetWeaver ABAP systems:
  - SAP NetWeaver 7.1 ABAP
  - SAP NetWeaver 7.0 SR<x> ABAP
- ASCS and SCS instance based on one of the following SAP NetWeaver ABAP+Java systems:
  - SAP NetWeaver 7.1 ABAP+Java
  - SAP NetWeaver 7.0 SR<x> ABAP+Java

1. Bring the SAP `<SAPSID>` SAPMNT cluster resource offline.
2. Double-click on this resource and choose *Properties*, and then the *Parameters* tab.
3. Change the *Share name* from `SAPMNT` to `SAPMNT<SAPSID>`.
4. Install the Windows Server 2003 Resource Kit Tools that include the `linkd.exe` program.
5. If not available, create the folder(s) `<drive>\usr\sap\<SAPSID>` on the local disk

![Caution]
You must create the folder(s) on all MSCS nodes using the same local disk letter.

6. Set the file security as follows:
   a) On the sap folder add the `SAP_LocalAdmin` local group and grant full permissions.
   b) On the `<SAPSID>` folder add the `SAP_<SAPSID>_LocalAdmin` local group and add full permissions.
7. Create the `saplog` share on the `<local_disk>\usr\sap\` folder and grant full access to the `SAP_LocalAdmin` group and local Administrators group.
8. Create the `sapmnt` share on the `<local_disk>\usr\sap\` folder and grant full access to the `SAP_LocalAdmin` group and local Administrators group.
9. Create the junctions with `linkd.exe` as shown in the table below using the following formula, in which source refers to the local disk and target refers to the shared disk:

```
linkd <source> <target>
```
Junctions for Existing 7.00 and 7.10 Systems

<table>
<thead>
<tr>
<th>SAP System</th>
<th>&lt;Source&gt;</th>
<th>&lt;Target&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>All SAP systems</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SYS</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SYS</td>
</tr>
<tr>
<td>Java system</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>ABAP system</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>ABAP+Java system,</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>(or 7.00 only: Java Add-In system)</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</td>
</tr>
</tbody>
</table>

10. Move the cluster group SAP <SAPSID> to another node.
11. Repeat steps 4 to 9.
12. Bring the cluster group online.

Preparing the ABAP Primary Application Server Instance (Central Instance)
The following procedure applies for the:
- Primary application server instance of a former SAP NetWeaver ’04 SR1 ABAP system that was upgraded to an SAP NetWeaver 7.1, or SAP NetWeaver 7.0 SR<x> system
- Primary application server instance and SCS instance of a former SAP NetWeaver ’04 SR1 based ABAP+Java system that was upgraded to an SAP NetWeaver 7.1, or SAP NetWeaver 7.0 SR<x> system.

**Note**
As of SAP NetWeaver 7.1, the central instance is called primary application server.

1. Bring the SAPMNT cluster resource offline.
2. Double-click on this resource and choose Properties, and then the Parameters tab.
3. Change the Share name from SAPMNT to SAPMNT<SAPSID>.
4. Bring the SAPLOC cluster resource offline.
5. Double-click on this resource and choose Properties, and then the Parameters tab.
6. Change the Share name from SAPLOC to SAPLOC<SAPSID>.
8. If not available, create the folder(s) <drive>:\usr\sap\<SAPSID> on the local disk

**Caution**
You must create the folder(s) on all MSCS nodes using the same local disk letter.
9. Set the file security as follows:
   a) On the sap folder add the SAP_LocalAdmin group and grant full permissions.
   b) On the <SAPSID> folder add the SAP_<SID>_LocalAdmin group and grant full permissions.
10. Create the saploc share on <local_disk>:\usr\sap\ folder and set full access to the
    SAP_LocalAdmin group and local Administrators group.
11. Create the sapmnt share on <local_disk>:\usr\sap\ folder and grant full access to the
    SAP_LocalAdmin group and local Administrators group.
12. Create the junctions with lnkd.exe as shown in the table below using the following formula, in
    which source refers to the local disk and target refers to the shared disk:
    lnkd <source> <target>

    **Junctions for Existing 6.40 Systems**

    | SAP System          | <Source>                                  | <Target>                                  |
    |---------------------|-------------------------------------------|-------------------------------------------|
    | All SAP systems     | <local_disk>:\usr\sap\<SAPSID>\SYS       | <shared_disk>:\usr\sap\<SAPSID>\SYS       |
    | ABAP system         | <local_disk>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number> | <shared_disk>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number> |
    | ABAP+Java           | <local_disk>:\usr\sap\<SAPSID>\SCS<Instance_Number> | <shared_disk>:\usr\sap\<SAPSID>\SCS<Instance_Number> |

    | ABAP+Java           | <local_disk>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number> | <shared_disk>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number> |

13. Move the cluster group SAP-R/3 <SAPSID> to another node.
14. Repeat steps 7 to 12.
15. Bring the cluster group online.

### 8.2.5 Preparing the Installation of Multiple SAP Systems in MSCS

SAP supports the installation of multiple SAP systems in a Microsoft cluster configuration. For each system you install in a Microsoft cluster you require a separate shared disk. In addition you need the tool lnkd.exe from Microsoft to create junctions. The executable is part of the Microsoft Windows Server 2003 Resource Kit Tools, which you can download from [http://www.microsoft.com](http://www.microsoft.com). Search for Microsoft Windows Server 2003 Resource Kit Tools.

**Note**

You can also use the 32-bit executable for 64-bit machines.
The following figure shows the directories to create on the local and shared disks as well as the junctions on two MSCS nodes. In this example there are three SAP systems (ABAP, Java, ABAP+Java) installed in the same MSCS cluster.

Figure 23: Directories and Junctions for Multiple SAP Systems in MSCS

Procedure
The following steps are only required if you want to install at least two SAP systems in one MSCS cluster.

1. If it does not exist, create the domain group: `<Domain>\SAP_<SAPSID>_GlobalAdmin`.
2. If it does not exist, create the local groups:
   - `SAP_LocalAdmin`<br>`SAP_<SAPSID>_LocalAdmin`<br>3. Move the shared disk to the MSCS node where you are logged on.
4. Create the following directories on the shared disk, using the following naming conventions:
   - `<shared_disk>:\usr\sap\<SAPSID>\SYS`<br>`<shared_disk>:\usr\sap\<SAPSID>\<instance_name><instance_number>`
**Example**

**ABAP system:**
- G:\usr\sap\C11
- G:\usr\sap\C11\ASCS01

**Java system:**
- H:\usr\sap\E12
- H:\usr\sap\E12\SCS02

**ABAP+Java**
- I:\usr\sap\F13
- I:\usr\sap\F13\SCS03
- I:\usr\sap\F13\ASCS04

5. Set the *File* security on the *shared* disk in the folder *sap* to *Full control* for `SAP_<SAPSID>_LocalAdmin` and `<Domain>\SAP_<SAPSID>_GlobalAdmin`.

6. Set the *File* security on the *shared* disk in the folder *usr* to *Full control* for `SAP_<SAPSID>_LocalAdmin`.

7. Create the following directories on the *local* disk of the MSCS node you are logged on for each SAP system you want to install in a Microsoft cluster:
- `<local_disk>:\usr\sap\<SAPSID>`

**Example**
- C:\usr\sap\C11
- C:\usr\sap\E12
- C:\usr\sap\F13

Move the groups containing the shared disk to the MSCS node you are logged on.

8. Create junctions on the *local* hard disk of this MSCS node with `linkd.exe` as shown in the table below using the following command:

```
linkd <source> <target>.
```

<table>
<thead>
<tr>
<th>SAP System</th>
<th>&lt;Source&gt;</th>
<th>&lt;Target&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>All SAP systems</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS</code></td>
</tr>
<tr>
<td>Java system</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS\SCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS\SCS&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td>ABAP system</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td>ABAP+Java system</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
</tr>
</tbody>
</table>
The following example shows the parameters you have to use for creating the junctions to install the three SAP systems, shown in the figure above.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ABAP system:</strong></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\C11\SYs G:\usr\sap\C11\SYs</code></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\C11\ASCS01 G:\usr\sap\C11\ASCS01</code></td>
</tr>
<tr>
<td><strong>Java system:</strong></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\E12\SYs H:\usr\sap\E12\SYs</code></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\E12\SCS02 H:\usr\sap\E12\SCS02</code></td>
</tr>
<tr>
<td><strong>ABAP+Java system:</strong></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\F13\SYs I:\usr\sap\F13\SYs</code></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\F13\SCS03 I:\usr\sap\F13\SCS03</code></td>
</tr>
<tr>
<td><code>linkd C:\usr\sap\F13\ASCS04 I:\usr\sap\F13\ASCS04</code></td>
</tr>
</tbody>
</table>

9. If they do not yet exist, create the `saploc` and `sapmnt` share on the `<local_disk:\usr\sap` folder and grant Full Control to the `SAP_LocalAdmin` group and local Administrators group.

10. Repeat steps 3 to 9 on the other MSCS nodes.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sapmnt</code> and <code>saploc</code> point to the local disk of each node.</td>
</tr>
</tbody>
</table>

### 8.3 Installation

The following sections provide information about how to install the SAP system for MSCS.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Make sure that you are logged on as domain administrator, unless otherwise specified.</td>
</tr>
<tr>
<td>■ If for any reason, you are not granted domain administrators rights, you can perform the installation as a domain user who is a member of the local administrators group. However, the domain administrator has to prepare the system appropriately for you. Do not use the user <code>&lt;sapsid&gt;adm</code> unless specified.</td>
</tr>
<tr>
<td>■ On the first MSCS node, in the <em>Cluster Administrator</em>, make sure that all existing cluster groups are online.</td>
</tr>
<tr>
<td>■ If you are prompted during the installation process, log off and log on again.</td>
</tr>
<tr>
<td>■ When you <em>reboot during the installation process</em> [page 147], resources fail over to the other MSCS node(s). Therefore, pause the other MSCS node(s) before the reboot.</td>
</tr>
</tbody>
</table>

You have to perform the following steps:
1. In the Cluster Administrator, you move all disk groups and the cluster group to the first MSCS node [page 147].
2. On the first MSCS node of the host where the database instance is to run, you cluster the MS SQL Server database software [page 142].
3. You install the central services instance (SCS) on the first MSCS node [page 148] of the host where the SCS instance is to run.
4. You configure the first MSCS node [page 148].
5. You install the database instance on the first MSCS node [page 149] of the host where the database instance is to run.
6. You install the host agent on the additional MSCS node [page 150] of the host where the host agent is to run.
7. You configure the additional MSCS node [page 151].
8. If required, you install an enqueue replication server [page 152] on the host where the enqueue replication server instance is to run.
9. You install the primary application server instance [page 153] on the host where the primary application server instance host is to run.
10. You install at least one additional application server instance [page 154] on the host where the additional application server instance is to run.

### 8.3.1 Clustering the SQL Server 2005 Database Server Software

This section describes how to install the SQL Server 2005 database server software for MSCS. The SQL Server 2005 database server software must be installed on the database host.

#### Note

- If you have installed the first SQL Server instance as named instance, you can install the second SQL Server instance as default instance.
- The additional clustered SAP system is installed in a different cluster group, and has a different IP address and different network name.
- If you install SQL Server 2005, make sure that the Windows Terminal Service is not started on the additional MSCS node.
- To install the client software, see *Installing the SQL Server 2005 Native Access Client Software Manually* [page 65].

#### Prerequisites

#### Note

- Make sure that you have not applied NTFS compression to the disk where you install the SQL Server software.
- You have installed Microsoft Distributed Transaction Coordinator (MSDTC). For more information on how to install MSDTC, see KB 301600 at support.microsoft.com/KB/301600.
- You have created domain user groups for each clustered service like SQL Server, SQL Agent, Full Text.
  - Ask the domain administrator to create the domain groups with the Group Type Security and Group Scope Domain Local.
  - The group names must already exist in the domain before you start the SQL Server 2005 installation.
  - Ask your domain administrator to add the startup account for each service to the respective domain groups.
  - Microsoft recommends that you use for each service a different domain group.
  - Microsoft recommends that you do not share the SQL server domain groups with other applications.
- You have created the SQL Server database cluster group and added the shared disks for the SQL Server databases to the group.

**Procedure**

1. Log on as a domain user who is a member of the local Administrators group on all MSCS nodes.
2. Insert the SQL Server 2005 RDBMS DVD in your DVD drive or mount it locally.
4. Start the installation program with `setup.exe`.
5. Enter the required information as specified in the table below:

<table>
<thead>
<tr>
<th>Window</th>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>End User License Agreement</td>
<td>Accept the licensing terms and conditions and choose Next.</td>
</tr>
<tr>
<td>Installing Prerequisites</td>
<td>Choose Install and, if required, Next.</td>
</tr>
<tr>
<td>Welcome to the Microsoft SQL Server Installation Wizard</td>
<td>Choose Next.</td>
</tr>
</tbody>
</table>

**Note**

The installation writes the log files to the directory `%ProgramFiles%\Microsoft SQL server\90\Setup Bootstrap\LOG`. You find the summary of the setup log in `summary.txt` in the same directory.
### 8.3 Installation

**Window: System Configuration Check**

<table>
<thead>
<tr>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>a) Check your system configuration and, if required, set up the required configuration.</td>
</tr>
</tbody>
</table>

**Note**
- For more information about the required system configuration for a software component, choose Message.
- IIS is not required for an SAP system. Therefore, you can ignore the warning about the IIS Feature Requirement.
- If there is a warning in COM Plus Catalog Requirement, correct the configuration before you proceed with the installation. Make sure that the Microsoft Distributed Transaction Coordinator (MSDTC) service is running.
- The system configuration is checked on all MSCS nodes.

b) Choose Next.

**Window: Components to Install**

<table>
<thead>
<tr>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>a) Select the following options:</td>
</tr>
</tbody>
</table>

  - SQL Server Database Services
  - Create a SQL Server failover cluster
  - Workstation components, Books Online and development tools.

**Note**
- The workstation components like SQL Management Studio, or Books Online are not installed on the additional MSCS node(s). To install them, start the installation program with `setup.exe` on the additional MSCS node(s), after you have finished the installation on the first MSCS node, and choose Workstation components.

b) Choose Advanced.

**Window: Feature Selection**

<table>
<thead>
<tr>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>a) Expand Database Services and deselect Replication</td>
</tr>
<tr>
<td>b) Expand Client Components and if available, deselect Business Intelligence Development Studio.</td>
</tr>
</tbody>
</table>

**Note**
- We recommend that you deselect these features as they are not required for an SAP system.

c) Choose Next.
### Server Input

<table>
<thead>
<tr>
<th>Window</th>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instance Name</strong></td>
<td>Select <em>Default Instance</em> and choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Virtual Server Name</strong></td>
<td>Enter the virtual server name and choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Virtual Server Configuration</strong></td>
<td>a) Select the public network and enter the IP address.</td>
</tr>
<tr>
<td></td>
<td>b) Choose <em>Add</em> and then <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Cluster Group Selection</strong></td>
<td>Select the cluster group where the virtual server resources are to be installed, and choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Cluster Node Configuration</strong></td>
<td>a) Select and add all MSCS nodes to be included in the virtual server.</td>
</tr>
<tr>
<td></td>
<td>b) Choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Remote Account Information</strong></td>
<td>Enter a domain administrator who is a member of the local Administrators group on all MSCS nodes, and choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Service Account</strong></td>
<td>a) Select <em>Use a domain user account</em> and enter the user name and password.</td>
</tr>
<tr>
<td></td>
<td>b) Choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Domain Groups for Clustered Services</strong></td>
<td>The startup account for each clustered service is added to the DomainName\GroupName to set its access control. If you do not have domain Administrator's rights, ask your domain administrator to add these user accounts to the appropriate domain groups. Enter the domain and group names of the clustered services and choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Authentication Mode</strong></td>
<td>a) Select <em>Mixed Mode</em> (<em>Windows Authentication and SQL Server Authentication</em>). This mode is required for a Java or ABAP+Java system. If you choose this mode, you set the password for the <em>sa</em> login.</td>
</tr>
<tr>
<td></td>
<td>Note SAPinst automatically changes the authentication mode into <em>Mixed Mode</em> when installing a Java system. The password for the <em>sa</em> login must comply</td>
</tr>
</tbody>
</table>
## 8.3 Installation

<table>
<thead>
<tr>
<th>Window</th>
<th>Server Input</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>with the Windows password policy.</td>
</tr>
<tr>
<td></td>
<td>b) Choose Next.</td>
</tr>
<tr>
<td><strong>Collation Settings</strong></td>
<td>a) Select SQL collations (used for compatibility with previous versions of SQL Server).</td>
</tr>
<tr>
<td></td>
<td>b) From the drop-down list select Binary order, based on code point comparison, for use with the 850 (Multilingual) Character Set.</td>
</tr>
<tr>
<td></td>
<td>c) Choose Next.</td>
</tr>
<tr>
<td><strong>Error and Usage Report Settings</strong></td>
<td>Leave the selection unchanged and choose Next.</td>
</tr>
<tr>
<td><strong>Ready to Install</strong></td>
<td>Choose Install.</td>
</tr>
<tr>
<td><strong>Setup Progress</strong></td>
<td><img src="Image" alt="Note" /> To see the log files for the SQL Server components, choose Setup finished. When the setup process has finished, choose Next.</td>
</tr>
<tr>
<td><strong>Completing Microsoft SQL Server 2005 Setup</strong></td>
<td>Choose Finish.</td>
</tr>
</tbody>
</table>

6. When you have finished the installation, enable the Named Pipes and TCP/IP protocol in the SQL Server Configuration Manager as follows:
   - Choose → All Programs → Microsoft SQL Server 2005 → Configuration Tools → SQL Server Configuration Manager.
   - Expand SQL Server 2005 Network Configuration and select one of the following:
     - For a default instance, select Protocols for MSSQLServer
     - For a named instance, select Protocols for `<SAPSID>`
     - In the right-hand pane, under Protocol Name, right-click Named Pipes and TCP/IP, and select Enable.

7. Restart SQL Server.

8. Install the latest SQL Server service pack and hotfix, if available. For more information, see SAP Note [62988](#).

9. Create the dependencies on the shared disks for SQL Server. Otherwise SAPinst fails to create the database files. Proceed as follows:
   a) In the Cluster Administrator, under the database group, right-click SQL Server and take it offline.
   b) Double-click the SQL Server cluster resource.
   c) In the Dependencies screen, choose Modify.
d) Move the disks to be used by SQL Server under Available resources to the Dependencies area.
e) Confirm your entries with OK.
f) In the Cluster Administrator, under the database group, right-click SQL Server, and bring all resources of the SQL cluster group online.

### 8.3.2 Moving MSCS Groups

During the cluster installation you have to move the database, SAP, or disk cluster groups from one MSCS node to the other before you can continue.

**Prerequisites**
- The groups you want to move are configured and are visible in the Cluster Administrator.
- For more information if you need to reboot during the installation, see Rebooting During the Installation or Conversion for MSCS [page 147].

**Moving Groups with the Cluster Administrator**

1. Start the Cluster Administrator with Start ➤ Programs ➤ Administrative Tools ➤ Cluster Administrator. ➤
2. In the Cluster Administrator, select the group you want to move and drag it to the required MSCS node on the left-hand pane.
3. Repeat the previous step for each group that you want to move.

### 8.3.3 Rebooting During the Installation or Conversion for MSCS

You only need to perform this procedure if you have to reboot during the installation or conversion for MSCS. A reboot means that resources fail over to another MSCS node. To avoid this, pause the additional MSCS node in the Cluster Administrator.

**Procedure**

1. Before the reboot, pause the additional MSCS node(s) in the Cluster Administrator.
2. After the reboot, activate the paused MSCS node(s) in the Cluster Administrator.
3. If you forgot to pause the MSCS node(s) before you reboot, perform the following steps:
   a) After the reboot, in the Cluster Administrator, move all resources back to the original node.
   b) Restart the Windows Server service.
### 8.3.4 Installing the Central Services Instance (SCS)

1. Run SAPinst [page 66] and choose \[ Your SAP System \] > Installation Options > High-Availability System > Based on <technical stack> > Central Services Instance (SCS) \].
2. If you are installing the SCS instance with SAPinst for the first time and SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

![Note]
For more information about the input parameters, position the cursor on a parameter and press \[ F1 \] in SAPinst.

![Caution]
The SCS installation drive must be a **shared** disk, which belongs to the SAP cluster group.

![Note]
If you have an MSCS configuration with more than two MSCS nodes in one cluster, you have to install and configure the SCS instance on **two** nodes only. These are also the nodes where you install the enqueue replication server.

![Caution]
**Multi-SID only:**
- In the SAPinst installation screen only the local drive letter and not the shared drive letter is displayed. However, since the link points to the shared drive, all files will be located on the shared drive.
- If you install multiple SAP systems in one MSCS cluster, make sure that you enter the SAP system ID and instance numbers as prepared when setting up the links. The instance number must be unique and not already used by another SAP system.

4. Check that the SCS instance is running.

### 8.3.5 Configuring the First MSCS Node

To configure the first MSCS node so that it functions properly in MSCS, you have to run the cluster configuration option offered by the SAPinst tool. When you run this option it:

- Creates the SAP cluster group
- Copies tools to the SAPCluster directory
Sets the SAPService to manual

⚠️ Caution
When you reboot during the conversion to MSCS [page 147], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

Prerequisites

- You are logged on to the first MSCS node as domain administrator or as a local user with domain administration rights. For more information, see Performing a Domain Installation without being a Domain Administrator [page 51].
- The SCS installation drive must be online on the first MSCS node.

Procedure

1. Run SAPinst and choose ➤ <Your SAP System> ➤ Installation Options ➤ High-Availability System ➤ Based on <technical stack> ➤ First MSCS Node ➤.

⚠️ Note
If SAPinst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

⚠️ Note
**Multi-SID only:**
If you install multiple SAP systems in one MSCS cluster, select Support of multiple SAP systems in one MSCS cluster.

⚠️ Note
For more information about the input parameters, position the cursor on the parameter and press F1 in SAPinst.

Result
SAPinst converts the SAP instances on the first MSCS node for operation in MSCS.

8.3.6 Installing the Database Instance

Prerequisites

- The SAP cluster group is Online on the first MSCS node.
- The DB cluster group is Online on the first MSCS node.
8.3 Installation

## Procedure

Perform the following steps on the first MSCS node.

1. On the first MSCS node, run SAPinst [page 66] and choose ``` <Your SAP System> ▶ SAP Systems with <Database> ▶ Installation Options ▶ High-Availability System ▶ Based on <technical stack> ▶ Database Instance ▶ ```
2. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
   a) For the profile directory you have to use the UNC path of the virtual (A)SCS host name, for example:
      ```\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.```  
   b) For the tempdb database, specify shared disks that are included in the MSSQL group.
   c) Distribute the transaction logs and SAPdata files to at least two different shared disks that are included in the MSSQL group. For more information, see: Distribution of Components to Disks for MSCS [page 123]

### Note

For more information about the input parameters, position the cursor on a parameter and press the [F1] key in SAPinst.

### 8.3.7 Installing the Host Agent on the Additional MSCS Node

You must install the host agent on the additional MSCS node(s). SAPinst installs the host agent with the instance number **99** and the SAP system ID **SAP**

#### Procedure

1. Run SAPinst [page 66] on the additional MSCS node and choose ``` <Your SAP System> ▶ Installation Options ▶ SAP Systems with <Database> ▶ High-Availability System ▶ Based on <technical stack> ▶ Host Agent ▶ ```
2. If SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

### Note

For more information about the input parameters, position the cursor on a parameter and press [F1] in SAPinst.

4. For Destination Drive, select the local drive on the MSCS node.
5. Start the installation.

### 8.3.8 Configuring the Additional MSCS Node

To configure the additional MSCS node(s) in the cluster, you have to run the MSCS configuration option for each additional MSCS node offered by the SAPInst tool. When you run this option it:

- Creates users and groups
- Sets the system and user environment
- Enters required port numbers in the Windows services file
- Creates the SAPService

---

#### Caution

When you **reboot during the conversion to MSCS** [page 147], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

---

#### Prerequisites

- You are logged on to the **additional** MSCS node as domain administrator or as a local user with domain administration rights. For more information, see *Performing an Domain Installation without being a Domain Administrator* [page 51].
- You have already configured the **first MSCS node** [page 148], which is the primary cluster node.

#### Procedure

1. Run SAPInst and choose **<Your SAP System>**  **Installation Options**  **SAP Systems with <Database>**  **High-Availability System**  **Based on <technical stack>**  **Additional MSCS Node**.

---

#### Note

If SAPInst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.
8.3 Installation

Note
For more information about the input parameters, position the cursor on the parameter and press F1 in SAPinst.

Note
Multi-SID only:
If you install multiple SAP systems in one MSCS cluster, select Support of multiple SAP systems in one MSCS cluster.

When you have made all required entries, SAPinst begins processing and converts the SAP instances on the other MSCS node for operation in MSCS.

3. When SAPinst has finished, start the SAP cluster group SAP <SAPSID> in the Cluster Administrator with Start All Programs Administration Tools Cluster Administrator 4.

8.3.9 Installing an Enqueue Replication Server

We strongly recommend to install an enqueue replication server with SAPinst on all MSCS nodes where an SCS instance is running.

Note
You have to perform the installation at least two times.

Prerequisites
- Your SCS instance is already clustered with MSCS.
- You have to install the enqueue replication server on a local disk.

Procedure
1. On the first MSCS node, log on as domain user who is a member of the local administrators group.
2. Run SAPinst [page 66] and choose < Your SAP System > Installation Options High-Availability System Based on <technical stack> Enqueue Replication Server 4.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.
   Note the following, when entering the parameters
   - On the SAPinst screen SAP Instance, enter the:
     - SAP system ID <SAPSID> of your SAP system
     - Instance number of the (A)SCS instance
     - Virtual instance host name of the (A)SCS instance
   - On the SAPinst screen Enqueue Replication Server Instance, enter a unique instance number that is not in use by another instance on this host.
Decide if you want to restart the (A)SCS instance and service cluster resources with SAPInst now, or later with the Cluster Administrator.

Note

You only need to do this once for all enqueue replication servers that you install on the MSCS nodes.

After you have entered all required input information, SAPInst starts the installation and displays the progress of the installation. During the process phase, the enqueue server instance is started. SAPInst installs the enqueue replication server instance on a local disk in the following directory:

\usr\sap\<SAPSID>\ERS<instance_number>\

Note

The profile is replicated from the global host to the local instance profile folder. The enqueue replication server instance uses the profile from the local instance profile folder:

\usr\sap\<SAPSID>\ERS<instance_number>\profile\

4. On the additional MSCS node, start SAPInst to install the enqueue replication server for the (A)SCS instance as described in step 2 above.

Note

There is no need to move the (A)SCS cluster group to another MSCS node.

5. Enter the required parameter values in the SAPInst dialogs as described above.

8.3.10 Installing the Primary Application Server Instance

The following describes how to install the primary application server instance for MSCS. You have the following options to install the primary application server instance:

- You install the primary application server instance on an MSCS node.
  In this case, bring the SAP cluster group online on this node, and make sure that the primary application server instance number is different from the (A)SCS instance number.
- You install the primary application server instance on a host outside of MSCS.
  In this case, you have to install the database client software on this host.

Procedure

1. Run SAPInst [page 66] and choose ▶ <Your SAP System> ▶ Installation Options ▶ High-Availability System ▶ Based on <technical stack> ▶ Primary Application Server Instance #.
2. If SAPInst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note

- For more information about the input parameters, position the cursor on a parameter and press [F1] in SAPinst.
- If you install the primary application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:
  - Profile Directory, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:
    \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
  - Destination Drive, you select the local disk where you want to install the primary application server instance. Do not enter the shared disk for the (A)SCS instance.

Note

If the destination drive is not shown and you cannot select it, the sap1oc share already exists. Since you already installed the ERS instance on the local drive, and the sap1oc share points to that local drive, SAPinst automatically takes that drive as destination drive.

4. Check that the primary application server instance is running.

### 8.3.11 Installing the Additional Application Server Instance

You have to install at least one additional application server instance for MSCS.

You have the following options to install the additional application server instance:

- You install the additional application server instance on an MSCS node.
  - In this case, bring the SAP cluster group online on this node, and make sure that the additional application server instance number is different from the (A)SCS instance number.
- You install the additional application server instance on a host outside of MSCS.
  - In this case, you have to install the database client software on this host.

Procedure

1. Run SAPinst [page 66] and choose <Your SAP System> Installation Tasks SAP Systems with <Database> High-Availability System Based on <technical stack> Additional Application Server Instance.
2. If SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
Note
For more information about the input parameters, position the cursor on a parameter and press [F1] in SAPinst.

Caution
- If you install the additional application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:
  - Profile Directory, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:
    \\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
  - Destination Drive, you choose the local disk where you want to install the additional application server instance. Do not enter the shared disk for the (A)SCS instance.

Note
If the destination drive is not shown and you cannot select it, the saploc share already exists. Since you already installed the ERS instance on the local drive, and the saploc share points to that local drive, SAPinst automatically takes that drive as destination drive.

4. If required, install more additional application server instances outside of MSCS.

Caution
Make sure that on the screen General SAP System Parameters for the Profile Directory, you use the UNC path of the virtual (A)SCS host name, for example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.

8.4 Post-Installation

This section describes how to complete and check the installation of the SAP system for an MSCS configuration:

1. You perform the post-installation checks for the enqueue replication server [page 156].
2. You perform the general post-installation steps [page 77] listed in this guide.

Additional Information
Starting and Stopping the SAP system in an MSCS configuration [page 158].
8.4.1 Post-Installation Checks for Enqueue Replication Server

Note

Make sure that you have restarted the (A)SCS instance and service cluster resources SAP <SAPSID> <(A)SCS_instance_number> Instance and SAP <SAPSID> <(A)SCS_instance_number> Service during the installation with SAPinst or with the Cluster Administrator.

The following sections describe the tests you must perform to check whether the installed enqueue replication server works properly. For these tests you use the ENQT and ENSMON command line tools, which allow remote access to the enqueue server statistics. Before you can use these tools you must copy them to the remote host where the Enqueue Replication Server is running and from where you want to start the tests.

You perform the following steps:

1. You copy ENQT.exe and ENSMON.exe from your cluster’s binary directory on the sapmnt share
   ```\<host>\sapmnt\<SAPSID>\SYS\exe\<codepage>\<platform>``` to a directory on the remote host from where you run the tests.
2. You check the status of the enqueue replication server with the ENSMON tool [page 156].
3. You check the fill status and ID of the lock table during failover with the ENQT tool [page 157].

8.4.1.1 Checking the Status of the Enqueue Replication Server with ENSMON

You use the ENSMON tool to check if the enqueue replication server and the enqueue server are properly connected.

Prerequisites

- You have started the (A)SCS instance of your SAP system.
- You run the ENSMON tool from the host where you installed the Enqueue Replication Server.

Procedure

To check the status of the enqueue replication server enter the following command:

```ensmon pf=<ERS_instance_profile> 2```

where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

- If the enqueue replication server and the enqueue server are properly connected, the output is similar to this:
  ```Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully```
Replication is enabled in server, repl. server is connected
Replication is active

If the enqueue replication server and the enqueue server are not properly connected, the output is similar to this:
Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, but no repl. server is connected

8.4.1.2 Monitoring the Lock Table During Failover with ENQT

With the following tests you monitor and check the lock table’s fill status and the lock table ID using the ENQT tool.

Prerequisites

■ You have started the (A)SCS instance of your SAP system.
■ You run the ENQT tool from the host where you installed the Enqueue Replication Server.

⚠️ Caution

Only use the ENQT commands stated in this procedure otherwise you might damage the enqueue server’s lock table.

Monitoring the Lock Table Fill Status During Failover with ENQT

1. Use the following command to fill the lock table of the enqueue server with 20 locks:
   enqt pf=<ERS_instance_profile> 11 20
   where <ERS_instance_profile> is the profile created during the installation of the Enqueue Replication Server.
2. Monitor the fill status of the lock table with the following command:
   enqt pf=<ERS_instance_profile> 20 1 1 9999
   This command continuously reads the content of the enqueue server’s lock table and returns the number of the table entries to the console.
3. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.
   The output is similar to this:
   Number of selected entries: 20
   Number of selected entries: 20
   Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 0 (enqueue server fails over)
Number of selected entries: 20 (enqueue server is running again)
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20

4. Make sure that the lock count is the same before and after the failover.

**Monitoring the Lock Table ID During Failover with ENQT**

1. Monitor the lock table ID during the failover with the following command:
   ```
   for /l %i in (1,1,100000) do enqt pf=<ERS_instance_profile> 97
   ```
   where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

2. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.
   The output is similar to this:
   ```
   ... (Output before failover)
   C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
   --REQ-------------------------------------------------------------
   EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759 / 9288
   ...
   (Output after failover)
   C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
   --REQ-------------------------------------------------------------
   EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759 / 9288
   ...
   ```

3. Make sure that the lock table ID (ENQID) is the same before and after the failover.

**8.4.2 Starting and Stopping the SAP System in an MSCS Configuration**

The following describes how to start or stop the SAP system in an MSCS configuration with the:
SAP MMC
Cluster Administrator

Note
- With the Cluster Administrator you can only start and stop the (A)SCS instance and the database instance.
- You also use the Cluster Administrator for all other administrative tasks like moving instances from one MSCS node to another MSCS node.

Procedure
- To start or stop your SAP system with the SAP MMC, see Starting and Stopping the SAP System [page 105].
- To start or stop the (A)SCS instance and the database instance with the Cluster Administrator do the following:
  1. Start the Cluster Administrator by choosing Start ▶ All Programs ▶ Administrative Tools ▶ Cluster Administrator.
  2. To start or stop the (A)SCS instance, right-click the instance SAP <SAPSID> <instance_no> Instance and choose Bring online or Take offline.
  3. To start or stop the database instance, right-click the <database_resource> and choose Bring online or Take offline.

End of: HA (MSCS)
No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System i5, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWERS, POWERS+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X, Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

MaxDB is a trademark of MySQL AB, Sweden.

SAP, R/3, mySAP, mySAP.com, xApps, xApp, SAP NetWeaver, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary. These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies (“SAP Group”) for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta [= 6.0 for E3]) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.

Disclaimer

Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components.

Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.
Legal Software Terms

Terms for Included Open Source Software
This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. **This software was developed using ANTLR.**
2. **SAP License Agreement for STLport**
   SAP License Agreement for STLPort between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)
   a) **Subject Matter of the Agreement**
      A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library (STLport) and its documentation without fee.
      B) By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the intellectual property laws, and to all of the terms and conditions of this Agreement.
      C) The Customer may distribute binaries compiled with STLport (whether original or modified) without any royalties or restrictions.
      D) Customer shall maintain the following copyright and permissions notices on STLport sources and its documentation unchanged: **Copyright 2001 SAP AG**
      E) The Customer may distribute original or modified STLport sources, provided that:
         - The conditions indicated in the above permissions notice are met;
         - The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:
           - Copyright 1994 Hewlett-Packard Company
           - Copyright 1997 Moscow Center for SPARC Technology.
           - Copyright 1999,2000 Boris Fomitchev
           - Copyright 2001 SAP AG
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC
makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice. Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.

All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.

B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.

C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.

D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.

E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and / or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 884621.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides
This page is intentionally left blank.